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Preface 
This guide describes how to use the Microplate Barcode Labeler to print and apply 
labels automatically to your labware. The Microplate Labeler can print linear and 
two-dimensional barcodes and human-readable text fields.
This preface contains the following topics:
• “About this guide” on page vi
• “Accessing Agilent Automation Solution user guides” on page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

What this guide covers

This guide provides descriptions of the Microplate Labeler and procedures for 
installation, setup, operation, and maintenance of the device. You use the Microplate 
Labeler Diagnostics software to set up the device, create label formats, and 
troubleshoot the device. You can access Microplate Labeler Diagnostics using the 
VWorks Automation Control software or the Microplate Labeler ActiveX controls.

What this guide does not cover

This guide does not provide instructions for the VWorks software, ActiveX controls, or 
third-party software. For more information about these topics, see “Related guides” on 
page vii.

What is new in this revision

Software version

This guide documents Microplate Labeler Diagnostics version 17.1.0 or later.

Job role Responsibilities

Installer Unpacks, installs, and tests the device before it is used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, or 
technician

• Manages the automation system that contains the device
• Develops the applications that are run on the system
• Develops training materials and standard operating 

procedures for operators

Operator Performs the daily production work on the device and solves 
routine problems.

Description See

Added information about the cab SQUIX 
printer.

“Hardware overview” on page 12
“Printer overview” on page 15
“Using the cab SQUIX printer 
touchscreen” on page 133
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Related guides

Use this guide in conjunction with the following:
• Automation Solutions Products General Safety Guide. Provides general safety 

information and describes potential safety hazards that you might encounter 
when using Automation Solutions products. A copy of this safety guide is included 
with your shipment.

• G5581A Microplate Labeler Unpacking Guide. Describes how to unpack the 
Microplate Labeler from the shipping containers.

• G5581A Microplate Labeler Media Loading Guide. Describes how to load the labels 
and ribbon in the printer on the Microplate Labeler. 

• VWorks Automation Control Setup Guide. Explains how to define labware and 
labware classes, liquid classes, and pipetting techniques, and how to track and 
manage labware in storage.

• VWorks Automation Control User Guide. Explains how to create protocols, set task 
parameters, and run protocols. Use this guide to set the parameters for the Print 
and Apply task when running a labeling protocol.

• Microplate Labeler ActiveX User Guide. Describes the ActiveX controls for the 
Microplate Labeler.

If the Microplate Labeler is a device in a third-party system, see the relevant third-party 
system guides.

Related topics

For more information about... See...

Reporting problems “Reporting problems” on page 137

Other devices “Accessing Agilent Automation Solution user 
guides” on page viii

Microplate Labeler safety “Safety guidelines” on page 1
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Accessing Agilent Automation Solution user guides

About this topic

This topic describes the different formats of user information and explains how to 
access it for the Agilent Automation Solutions products.

Where to find user information

The Automation Solutions user information is available in the following locations:
• Knowledge base. The help system that contains information about all the 

Automation Solutions products is available from the Help menu within the VWorks 
software. 

• PDF files. The PDF files of the user guides are installed with the VWorks software 
and are on the software CD that is supplied with the product. A PDF viewer is 
required to open a user guide in PDF format. You can download a free PDF viewer 
from the internet. For information about using PDF documents, see the user 
documentation for the PDF viewer.

• Agilent website. You can search the online knowledge base or download the latest 
version of any PDF file from the Agilent website at www.agilent.com/chem/askb. 

Accessing safety information

Safety information for the Agilent Automation Solutions devices appears in the 
Automation Solutions Products General Safety Guide and in the corresponding device 
safety guide or user guide.
You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as Microsoft 
Internet Explorer and Mozilla Firefox.
Note: If you want to use Internet Explorer to display the topics, you might have to allow 
local files to run active content (scripts and ActiveX controls). To do this, in Internet 
Explorer, open the Internet Options dialog box. Click the Advanced tab, locate the 
Security section, and select Allow active content to run in files on my computer.

To open the knowledge base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.
• From the Windows desktop, do one of the following:

– Windows 10. Select Start > All Apps > Agilent Technologies > VWorks 
Knowledge Base.

– Windows 7. Select Start > All Programs > Agilent Technologies > VVWorks > 
User Guides > VWorks Knowledge Base.

https://www.agilent.com/chem/askb
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . The pointer 

changes to . Notice that the different icons or areas are highlighted as you 
move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:
• Contents. Lists all the books and the table of contents of the books.
• Index. Displays the index entries of all of the books.
• Search. Allows you to search the Knowledge Base (all products) using 

keywords. You can narrow the search by product.
• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or previous 
topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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1 Safety guidelines
Before installing and using the Microplate Labeler, you must be familiar with the 
potential safety hazards and how to avoid them.
This chapter contains the following topics, which describe the safety information 
for the Microplate Labeler:
• “General safety information” on page 2
• “Safety and regulatory compliance” on page 3
• “Stopping in an emergency” on page 5
• “Potential safety hazards” on page 6
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General safety information

Before installing and using the device

Before using the Microplate Labeler, make sure that you are properly trained in:
• General laboratory safety
• The correct and safe operation of the Microplate Labeler
• The correct and safe operation of lab automation systems or components used in 

combination with the Microplate Labeler

General safety precautions

For the general safety precautions, the intended product use statement, and the list of 
safety labels, see the Automation Solutions Products General Safety Guide. 

Related information

For information about... See...

Precautions for potential hazards 
specific to the Microplate Labeler

“Potential safety hazards” on page 6

Regulatory compliance “Safety and regulatory compliance” on 
page 3
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Safety and regulatory compliance

Compliance standards

The Microplate Labeler complies with the applicable EU Directives and bears the CE 
mark. See the Declaration of Conformity or Declaration of Incorporation, as applicable, 
for details. The Microplate Labeler is designed to comply with the regulations and 
standards listed in the following table. 

Electromagnetic compatibility
If the Microplate Labeler causes interference with radio or television reception, which 
can be determined by turning the device off and on, try one or more of the following 
measures:
• Relocate the radio or television antenna.
• Move the device away from the radio or television.
• Plug the device into a different electrical outlet, so that the device and the radio or 

television are on separate electrical circuits.
• Make sure that all peripheral devices are also certified.
• Make sure that appropriate cables are used to connect the device to peripheral 

equipment.

Regulatory Compliance Standard

EMC

European Union EMC Directive 2014/30/EU

IEC 61326-1:2012 / EN 61326-1:2013

Canada ICES/NMB-001:2006

Australia/New Zealand AS/NZS CISPR 11:2011

RoHS

European Union RoHS Directive2011/65/EU

Safety

European Union Machinery Directive 2006/42/EC

Low Voltage Directive 2014/35/EU

IEC 61010-1:2010/EN61010-1:2010
IEC 61010-2-081:2015/EN 61010-2-081:2015

Canada CAN/CSA-C22.2 No. 61010-1-12
CAN/CSA-C22.2 No. 61010-2-081-15

USA ANSI/UL 61010-1-2012
ANSI/UL 61010-2-081:2015



1   Safety guidelines
Safety and regulatory compliance

4 G5581A Microplate Labeler User Guide

• Consult your equipment dealer, Agilent Technologies, or an experienced technician 
for assistance.

Changes or modifications not expressly approved by Agilent Technologies could void 
the user's authority to operate the equipment.

South Korea EMC Declaration
The following EMC declaration applies to:

1 All models that were registered on or after 7 December 2016, but
2 Not to models included in a product family or series that was registered before 7 

December 2016 (even if the model was added to the product family or series on or 
after 7 December 2016).

EMC declaration for South Korea
This equipment has been evaluated for its suitability for use in a commercial 
environment. When used in a domestic environment, there is a risk of radio 
interference.

 

Sound emission declaration
Sound pressure: Lp < 70 dB according to EN ISO 779:2010.
Schalldruckpegel: Lp < 70 dB nach EN ISO 779:2010.

Related information

For information about... See...

General precautions, intended use 
statement, and safety labels

Automation Solutions Products General 
Safety Guide

Potential hazards “Potential safety hazards” on page 6

Stopping in an emergency “Stopping in an emergency” on page 5
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Stopping in an emergency

Emergency stops

To stop in an emergency:
1 Unplug the power cord from the Microplate Labeler or set the power switch to off 

( O ).
Make sure that the point at which the detachable power cord is connected to the 
Microplate Labeler is clear from clutter and that it is accessible at all times.

2 Turn off the air supply.

Figure Microplate Labeler power entry (rear view)

If the Microplate Labeler is integrated in an automation system, follow the emergency-
stop protocol for that system.

Related information

For information about... See...

General safety guidelines Automation Solutions Products General 
Safety Guide

Potential hazards “Potential safety hazards” on page 6
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Potential safety hazards

About this topic

This topic describes potential hazards that you can encounter when using the 
Microplate Labeler.

Mechanical hazards

The Microplate Labeler contains the following moving parts. 

Figure Microplate Labeler moving parts

WARNING
Pinch hazard! Do not reach between the plate stage and applicator head or between 
the applicator head and the printer while the device is on. 

Item Description

1 Plate stage. Automatically rotates side to side during labeling to present the 
long and short sides of a microplate to the applicator head.

2 Applicator head. Automatically rotates between the printer and the plate 
stage to apply the barcode labels.

3 Printer. Contains various parts that move automatically during a print run. 
Keep the cover closed while the device is operating. 
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WARNING
Pinch hazard! Use care when closing the printer cover. Keep clear of the cover 
hinges and do not reach into the swivel range of the cover. If you operate the printer 
with the cover open or with the cover removed, ensure that you keep clear of the 
exposed rotating parts.

Burn hazard

WARNING
The printer can become hot while printing. Do not touch the printer components 
during operation. Allow the printer to cool down before changing the media or 
cleaning the printer components.

Related information

For more information about… See…

General safety “General safety information” on page 2

Locations of hardware components “Hardware overview” on page 12

Site laboratory requirements “Laboratory requirements” on page 31

Reporting problems with the 
Microplate Labeler

“Reporting problems” on page 137
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2 Introduction to the Microplate Labeler
This chapter provides the background information required to successfully operate 
the Microplate Labeler. 
The topics are:
• “About the Microplate Labeler” on page 10
• “Hardware overview” on page 12
• “Overview of the controlling software” on page 20
• “Microplate labeling tips” on page 22
• “Labware considerations” on page 22
• “Introduction to microplate labels and barcodes” on page 25
• “How the device applies a label” on page 27
• “Overall setup workflow” on page 28
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About the Microplate Labeler

Description

The Microplate Labeler prints labels and applies them to labware. 

Figure Microplate Labeler

You can create and apply the same or a different label on up to four sides of a 
microplate. Each label can include up to six fields, including a barcode field and 
human-readable text fields. 

Figure Microplate (side view) with barcode label

An optional barcode reader can verify that the barcode has been printed and applied 
correctly, and can be used to clone an existing barcode.

System configuration variations

A Microplate Labeler can be used in the following configurations:
• Integrated in a BenchCel workstation
• As a standalone device
• Integrated with a third-party lab automation system

Integrated in an Agilent BenchCel Workstation
When the Microplate Labeler is integrated with a BenchCel Workstation:
• The VWorks software controls the device to perform labeling protocols 

automatically.

label example
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• The BenchCel robot automatically moves the microplates to and from the 
Microplate Labeler plate stage.

Figure BenchCel Workstation integrated with Microplate Labeler (right)

Standalone Microplate Labeler
When used as a standalone device:
• The VWorks software controls the device to perform labeling protocols 

automatically. 
• The operator places a microplate on the plate stage, presses the green button to 

perform the print-and-apply operation, and then replaces the labeled microplate 
with the next microplate to be labeled.

IMPORTANT
The Microplate Labeler is designed to generate printed adhesive labels that are 
automatically applied to microplates. Although it is possible to print a single test label, 
manually peel the label off the backing, and place the label on a microplate by hand, 
printing of multiple labels for manual application is not supported for a standalone 
Microplate Labeler.

Integrated in a third-party lab automation system
When the Microplate Labeler is integrated in a third-party lab automation system, the 
third-party software uses the Microplate Labeler ActiveX controls to perform labeling 
protocols.

Related topics

For information about... See...

Instrument control software “Overview of the controlling software” on 
page 20

Workflows for set up and use “Overall setup workflow” on page 28

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Hardware overview

About this topic

This topic describes the Microplate Labeler hardware features, including the optional 
barcode reader.

Front view

The Microplate Labeler is comprised of a barcode applicator and label printer 
assembled on a baseplate.

Figure Microplate Labeler components (front view)

2

1

3

6   7

4                    5

Item Feature Description

1 Printer Prints a label (600 dpi) and pauses when the label reaches the peelbar to allow 
the applicator head to retrieve the printed label. The printer supports the printing 
of linear or two-dimensional (2D) barcodes.
A Microplate Labeler that is fitted with the cab SQUIX model printer has a 
touchscreen. For details, see “Using the cab SQUIX printer touchscreen” on 
page 133.
The cab A2+ model printer has a display and navigation pad. For details, see 
“Using the cab A2+ printer display and navigator pad” on page 135.

2 Applicator Contains the plate stage, applicator head, green button, electronics, and the 
connection panel (back side) for the device.
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3 Plate stage Provides a platform to support a plate delivered by a robot or a person. 
The plate stage rotates side to side to enable labeling on all four sides of a 
microplate. The plate stage rotation also allows the optional barcode reader to 
read any side of a microplate. 
The plate stage can move up and down to provide a choice of two vertical 
labeling positions to accommodate labware of varying heights.

IMPORTANT If you purchased a standalone Microplate Labeler and later 
decide to integrate the device with a BenchCel Workstation, a different type of 
plate stage may be required. Contact Agilent Automation Solutions Technical 
Support for more information.

4 Green button Starts a print-and-apply operation for printing test labels.

5 Applicator head Rotates between the printer and the plate stage. Uses vacuum pads (suction 
cups) to pick up a printed label from the printer and apply the label to a 
microplate on the plate stage.

6 Vacuum pads Uses vacuum to pick up a label from the printer and uses compressed air to 
apply the label to a microplate on the plate stage.

7 Printer peelbar Provides a platform for presenting each label to the applicator head vacuum 
pads. As the label strip travels over the peelbar, each label lifts off the label 
backing slightly to allow the applicator head to pick up the label.

Item Feature Description
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Connection panel (back view)

The Microplate Labeler connection panel is on the back of the applicator, next to the 
printer. 

Figure Microplate Labeler connection panel (back view)

Item Feature Description

1 Air supply port Connects to a compressed-air source. The device 
uses compressed air to:
• Move the plate stage up and down
• Rotate the applicator head side to side
• Extend and retract the applicator head
• Create a vacuum that the applicator head uses to 

pick up labels from the printer
• Apply labels to a microplate

2 Ethernet port Connects an Ethernet cable from the controlling 
computer to the Microplate Labeler for 
communication.

IMPORTANT Ethernet is the recommended mode 
of communication. If you connect to the Microplate 
Labeler using the Ethernet port, you do not use the 
serial port.

3 Barcode reader 
port

Connects the cable from the optional barcode reader 
to the Microplate Labeler for communication.
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Printer overview

CAUTION
Do not use the touchscreen or navigator pad to adjust the printer settings unless 
directed to do so by Agilent Automation Solutions Technical Support. Using the 
printer touchscreen (cab SQUIX) or navigator pad (cab A2+) to change the printer 
settings can cause the Microplate Labeler to fail. The printer has been specially 
configured as part of the Microplate Labeler. 

IMPORTANT
The printer display must show the Ready message before you can initialize the device. 
During operation, the software displays operator messages and error messages on the 
computer screen. 

4 Serial port Connects a serial cable from the controlling computer 
to the Microplate Labeler to provide serial 
communication.
You can use the 1.8-m (6-ft) serial-communications 
cable (beige) provided in the Microplate Labeler utility 
kit.
Note: If you connect to the Microplate Labeler using 
the serial port, you do not use the Ethernet port.

5 Power switch Turns on (|) or off (o) the power.

6 AC power port Connects the power cable.

7 Pressure gauge Indicates the regulated air pressure.

8 Air pressure 
regulator

Regulates the incoming air pressure to ensure that 
the device’s internal components are not exposed to 
air pressure that is too high. 

9 Fuse holder Houses the electrical fuse.

Item Feature Description
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Printer front view

Figure Printer front view (A) cab SQUIX printer, (B) cab A2+ printer
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Item Feature Description

1 Cover Removable transparent plastic cover that opens to 
provide access for cleaning the printer components 
and changing the media.

2 cab SQUIX printer 
touchscreen

Displays the Ready message and various messages 
for service, and provides access to the Help menu 
that contains how-to videos for maintaining the 
printer. For details, see “Using the cab SQUIX printer 
touchscreen” on page 133.

3 cab A2+ printer 
service display

Displays the Ready message and various messages 
for service. For details, see “Using the cab A2+ printer 
display and navigator pad” on page 135.

4 cab A2+ service 
navigator pad

Used by the factory and field service personnel to set 
up the printer or change settings on the printer.
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Printer side view

Figure Printer side view with cover removed

                                                        

6

7

1

2

3

4

5

Item Feature Description

1 Ribbon supply hub Holds the unused printer ribbon roll.
The printer requires the Microplate Labeler Media Kit 
(not shown), which contains the thermal transfer 
ribbon and labels for the printer.

2 Ribbon take-up 
hub

Rewinds the used ribbon.

3 Printhead (hidden 
under the ribbon)

The narrow bar that presses the image through the 
ribbon and onto the label as the media move into 
position on to the print roller. 

4 Print roller and 
rewind assist 
roller

The rollers that assist in moving the label strip under 
the printhead (print roller) and to the internal rewinder.

5 Internal rewinder Rewinds and holds the used label strip.

6 Roll retainer Holds the unused label roll.

7 Margin stop Locks the roll retainer and holds the ribbon roll 
securely in place.
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Barcode reader

The optional barcode reader is connected to the Microplate Labeler so that it can be 
used with the software to verify or clone barcodes.

IMPORTANT
Successful integration of a barcode reader requires that the barcode reader have the 
correct pinouts, power, and is able to communicate the correct commands to the 
Microplate Labeler. 

Figure Microplate Labeler with barcode reader installed

Related information

For information about... See...

Barcodes • “Introduction to microplate labels and 
barcodes” on page 25

• “Barcodes and supported symbologies” 
on page 97

The labeling process “How the device applies a label” on page 27

How to install and use the barcode 
reader

Agilent  Automation Solutions Technical 
Support
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Overview of the controlling software

About this topic

This topic describes the software components you use to operate the Microplate 
Labeler:

Microplate Labeler Diagnostics overview

Microplate Labeler Diagnostics is a component of the provided software. You can 
access Microplate Labeler Diagnostics through the VWorks software or the ActiveX 
controls. 
You use Microplate Labeler Diagnostics to set up and troubleshoot the device, 
including:
• Create and manage profiles. A profile allows you to set up communication 

between the Microplate Labeler and the controlling computer.
• Create and edit label formats. You can use the provided templates and customize 

them to create your own label formats.
• Perform test print-and-apply operations. You can print test labels when verifying a 

label format design, setting up the device, or troubleshooting problems.
• Set up the plate stage positions. If required, you can adjust the plate stage 

positions, for example the robot pickup angle for a device that is integrated in an 
automation control system. 

• Check the basic device functions. You can actuate the pneumatic controls to verify 
the device functioning and to check the alignment of the plate stage and 
applicator head.

Access to Microplate Labeler Diagnostics depends on the automation control 
software you are using. 
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Automation control software

You can use either the VWorks software or third-party automation software to operate 
the Microplate Labeler in protocol runs. If you plan to use third-party automation 
software, you will need to use the Microplate Labeler ActiveX control to permit the 
software to interface with the device.

VWorks software 
The VWorks software enables you to:
• Set up the devices. During setup, you create device files for your specific set of 

devices. You can also create user accounts with different levels of privileges to 
enforce access policies.

• Define labware. Labware definitions describe the type and the geometry of the 
labware that the devices will be handling during the protocol runs. For the 
Microplate Labeler, the labware definition includes the plate stage height. For 
instructions, see the VWorks Automation Control Setup Guide.

• Create protocols. Protocols determine the sequence of tasks that you want to 
automate in a run. For example, you can use a protocol to apply barcode labels to 
100 microplates automatically. 

• Run, pause, monitor, and stop protocols. You can start, pause, monitor, and stop a 
protocol run from the controlling computer. 

For more details, see the VWorks Automation Control User Guide.

ActiveX control
Instead of using the VWorks software, you can use another automation control 
software to operate the Microplate Labeler in protocol runs. The Microplate Labeler 
ActiveX control allows the automation software to interface with the device. For more 
information, see the Microplate Labeler ActiveX User Guide.

For information about... See...

Starting Microplate Labeler 
Diagnostics

• “Opening Diagnostics” on page 62
• “Quick reference to Diagnostics software” on 

page 139

VWorks software • “Creating a VWorks device file” on page 58
• VWorks Automation Control User Guide

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Microplate labeling tips 

The labeling quality depends on the following factors. 

Labware considerations

About this topic

This topic provides guidelines for selecting automation-ready labware for use with the 
Microplate Labeler.

Acceptable microplates

The Microplate Labeler accommodates a wide range of microplates that meet 
American National Standards Institute (ANSI) Standards ANSI/SBS 1-2004 through 
ANSI/SBS 4-2004. 
Note: You can contact the labware manufacturer to inquire about ANSI-compliant 
labware. 
For use of nonconforming labware, contact Agilent  Automation Solutions Technical 
Support.

Figure Microplate (side view) with barcode label

About label placement

The Microplate Labeler is designed to place the labels as follows:

Factor Description See …

Labware selection Microplate material and design contribute to how 
well a label adheres to the side of a microplate.

“Labware considerations” on 
page 22

Label placement The position of the label on the microplate can 
affect label adhesion and whether a barcode 
reader can scan the barcode.

“Labware considerations” on 
page 22

Media selection The quality of the adhesive labels determines how 
well the Microplate Labeler can pick-and-apply a 
label. The ribbon and label also play a big role in 
how successful readers will be in decoding the 
symbology and the ability of the label to withstand 
exposure to chemicals and temperature and 
humidity extremes.

Agilent Media Kit

Label format design The label design must meet certain criteria to 
ensure the readability by barcode readers and 
humans.

“About label formats and 
content” on page 80

label example
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• Centered horizontally (left to right) on of any of the four sides of a microplate.
• At either of two vertical positions on the microplate. This feature accommodates 

the labware of varying sizes or that have different skirt heights.

Figure Examples of label positions on different sizes of labware

On microplates with tall skirts, labels may be placed on the skirt, but should be 
evaluated for compatibility with the application. See the following guidelines.

Labware selection guidelines

To attach a label to a microplate successfully, the Microplate Labeler requires a flat, 
even surface that is slightly larger than the label. Applying labels to an uneven surface, 
for example overlapping the edge of a microplate skirt, results in problems with label 
adhesion. 
The following table provides guidelines. Evaluate the make and model of all your 
microplates to ensure consistent results for all application conditions.

Criteria Guidelines

Microplate 
design

Avoid microplates with the following features that can interfere 
with label placement and adhesion:
• Microplates with tall, raised skirts

• Microplates with raised surfaces on the sides

• Low-profile microplates with no skirt or half-skirted 
microplates, such as PCR plates, where the available height 
for label placement is very near or less than the height of the 
label 
Such microplates may also be incompatible with the 
Microplate Labeler plate stage.

• Microplates with holes in the sides, which can reduce 
adhesion of the label
Holes can also be challenging for robotic grippers.

label example

label example
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Related topics

Microplate 
material

The Microplate Labeler is designed for compatibility with 
labware that features plasticized surfaces, such as 
polypropylene or polystyrene. For the best results, apply the 
adhesive labels to labware that is:
• Dry and at room temperature 
• Clean and has not been subjected to liquids or powders that 

can reduce or prevent adhesion of the labels 
• Not warped

Warped microplates can hamper the device’s ability to 
repeatably place labels at the same position on all 
microplates within a run.

Criteria Guidelines

For information about... See...

Label formats and content “About label formats and content” on 
page 80

Plate stage and applicator head 
positions

“About plate stage and applicator head 
positions” on page 69

Setting the height of the plate stage 
position

“Setting the plate stage vertical positions” 
on page 72
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Introduction to microplate labels and barcodes

About this topic

This topic provides an overview of the labels that you can create for the Microplate 
Labeler and a general description of barcode types.

Microplate labels

The labels that you create for the Microplate Labeler can contain up to six fields of 
data, including one barcode field and five human-readable text fields. The following 
figure shows an example of a typical label that contains two fields: one barcode field 
and one human-readable field. 

Figure Example of a microplate barcode label

In the example, the barcode field has a blank margin (quiet zone) on each end to 
ensure that a barcode reader can read the barcode successfully. For more details on 
label design, see “About label formats and content” on page 80.

About barcodes

Barcodes contain information that can be read automatically, facilitating the fast and 
accurate tracking of microplates in lab automation systems. A barcode reader scans 
the line patterns, and software converts the encoded patterns into usable information. 
The method used for creating a barcode from text is called its symbology. Your choice 
of symbology depends on the barcode reader used for your application and your 
laboratory preferences.
The Microplate Labeler can print either linear or two-dimensional (2D) barcodes.

Linear barcodes
A linear barcode is a sequence of parallel bars and spaces of variable widths that are 
arranged in groups. Each group represents an individual number, letter, or symbol. 
Within each group, the information is encoded by the relative thicknesses and relative 
positions of the bars and spaces. A linear barcode symbol contains a leading blank 
margin (quiet zone), a start character, one or more data characters, a stop character, 
and a trailing quiet zone.

Figure Example of a linear barcode using Code 128 symbology

Blank margins (quiet zones)

5.08 cm (2 in)

0.635 cm (0.25 in)
Barcode

Human 
readable
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Two-dimensional barcodes
2D barcodes are comprised of dots or small bars arranged as a matrix or in a stacked 
arrangement. The 2D barcodes typically can contain more information than linear 
barcodes because they encode data in both the vertical and horizontal directions. 

Figure Example of a 2D barcode using Data Matrix symbology

Related topics

For information about... See...

Label formats and content “About label formats and content” on 
page 80

Barcodes symbologies “Barcodes and supported symbologies” on 
page 97
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How the device applies a label

About this topic

This topic describes what happens when you run a Microplate Labeler print-and-apply 
task. 

Process

The following sequence of events occurs when you start a print-and-apply task:

1 The Microplate Labeler prints the label and moves the printed label forward to the 
peelbar on the printer. As the label strip reaches the peelbar, the printed label lifts 
off the backing.

2 The applicator head extends towards the printer until the vacuum pads touch the 
printed label.

3 A vacuum is created in the applicator head’s vacuum pads to grip the label.
4 After the vacuum is sensed, the applicator head retracts with the label held by the 

vacuum pads.
5 The plate stage rotates so that the selected side of the microplate is facing the 

applicator head. 
6 The applicator head rotates until it is perpendicular to the microplate on the plate 

stage, and then extends, pushing the label onto the microplate.
7 Air is pushed through the vacuum pads, breaking the vacuum seal.
8 The applicator head retracts and returns to face the printer.
9 The plate stage moves to the next selected position.

Related topics

For information about... See...

Locations of hardware components “Hardware overview” on page 12

Workflows for operating the 
Microplate Labeler

“Overall setup workflow” on page 28
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Overall setup workflow 

About this topic

This topic describes the workflow for setting up and operating an integrated device 
using the VWorks software.
Note: The steps for installing and operating the Microplate Labeler in a third-party lab 
automation system might differ. For details, see the Microplate Labeler ActiveX User 
Guide and the third-party user documentation provided with that system. 

Workflow for the VWorks software

Step Procedure For more details, see…

1 Install the Microplate Labeler. “Installation workflow” on page 30

2 Install the VWorks software, or integrate the 
Microplate Labeler ActiveX control.

Software release notes

3 Start the VWorks software and log in. VWorks Automation Control Setup Guide

4 Set up the Microplate Labeler. “Setup workflow” on page 56

5 Determine which label format you want to use.
The software includes a variety of templates that 
you can use or customize for your application.

“Creating and editing label formats” on page 84

6 Specify the plate stage height for your labware in 
the labware definitions using the Labware Editor.

VWorks Automation Control Setup Guide 

7 Perform a test print-and-apply test from 
Microplate Labeler Diagnostics to check the 
label format and label position on the 
microplate.

“Performing a print-and-apply test” on page 106

8 Create the protocols to run the labeling task. You 
set the labeling task parameters, including the 
label content, and select the label format for 
each labeling task.

VWorks Automation Control User Guide, Print and 
Apply task 

9 Start the protocol. VWorks Automation Control User Guide



29

3 Installing the device
This chapter describes how to unpack and install the Microplate Labeler. 
The topics are:
• “Installation workflow” on page 30
• “Laboratory requirements” on page 31
• “Connecting the air tubing: non-metric” on page 34
• “Connecting the air tubing: metric” on page 36
• “Setting the air pressure” on page 38
• “Connecting the power cord” on page 39
• “Connecting the device to the computer” on page 41
• “Loading labels and ribbon” on page 44
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Installation workflow

About this topic

This topic provides the workflow for installing a Microplate Labeler. Typically, Agilent 
Technologies completes this initial installation for you.

Workflow

Related topics

Step For this task... See...

1 Ensure that your laboratory 
meets the site requirements.

“Laboratory requirements” on page 31

2 Unpack the Microplate Labeler. Microplate Labeler Unpacking and 
Packing Guide

3 Connect the air tubing. • “Connecting the air tubing: non-
metric” on page 34

• “Connecting the air tubing: metric” 
on page 36

4 Connect the Microplate Labeler 
to the power source.

“Connecting the power cord” on 
page 39

5 Connect the Microplate Labeler 
to the computer using either an 
Ethernet or serial connection.

 “Connecting the device to the 
computer” on page 41

6 Install the automation control 
software, for example, the 
VWorks software.

Software release notes

7 Install the labels and ribbon in the 
printer.

“Loading labels and ribbon” on 
page 44

8 Optional. Install the barcode 
reader.

Agilent Automation Solutions 
Technical Support

For information about... See...

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 137
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Laboratory requirements

About this topic

This topic describes the requirements for the site where you plan to install the 
Microplate Labeler. The topics are:
• “Laboratory space requirements” on page 31
• “Electrical requirements” on page 32
• “Compressed air requirements” on page 32
• “Environmental requirements” on page 33
• “Computer requirements” on page 33
• “Consumables” on page 34

Laboratory space requirements

General bench requirements
Make sure the bench for the Microplate Labeler has the following:
• Sufficient space to accommodate the Microplate Labeler, computer, monitor, and 

accessories
• Sufficient clearance: 

– On the back of the device to access power, communication, and air tubing 
connections

– Above the printer to open the printer cover
– On the side of the printer to replace the label and ribbon rolls
Note: The snap-off cover can be removed from the printer if the device is 
operated within an enclosure where no corrosive chemicals or gases are 
present.

• A fixed bench (without wheels) that can support the weight of the Microplate 
Labeler without excessive shaking or movement

• Proper height for any operator to comfortably operate the Microplate Labeler

Physical specifications

Note: Measurements do not include the cables or the computer.

Dimension Value

Width 28.7 cm (11.3 in) 

Height 35.1 cm (13.8 in)

Height with printer cover 
opened 

48.8 cm (19.2 in)

Depth 62.2 cm (24.5 in) 

Weight 21 kg (47 lbs) 
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Figure Dimensions (front and side views)

Figure Microplate Labeler with printer cover open (front view)

Electrical requirements

The Microplate Labeler device has the following power requirements: 

Compressed air requirements

The Microplate Labeler requires the use of clean, dry, compressed air to move the 
pneumatic components. The compressed air can be from the following sources:
• Centralized source (laboratory)
• Compressed-air cylinders
• Portable pumps

Utility Requirement

Electrical 100–240~, 50/60 Hz, 2.75 A

Fuse Two 3 A, 0.25 x 1.25 in (6.35 x 31.75 mm), fast acting
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CAUTION
Ensure that the air coming into the Microplate Labeler is properly filtered from 
moisture or aerosolized impurities. Significant moisture or impurities in the air line 
can adversely affect the performance and life of the Microplate Labeler. Using oil 
compressors can cause oil to leak into the Microplate Labeler and void your 
warranty.

The Microplate Labeler has the following minimum compressed-air requirements:

Environmental requirements

The Microplate Labeler is for indoor use only. The following table lists the operating 
specifications for the device.

Make sure the Microplate Labeler is located away from moisture (sprays of water or 
mists).
The Microplate Labeler uses adhesive labels that are compatible with most common 
laboratory solvents, including DMSO and alcohols. The labels can withstand exposure 
to temperatures of –80 °C to 100 °C.

Computer requirements

The requirements of the controlling computer depend on the lab automation software 
you are using. 
• VWorks software computer requirements. See the VWorks software release notes 

or the Automation Solutions Knowledge Base at www.agilent.com/chem/askb. 
• Third-party automation software requirements. See the user documentation 

supplied with the product.
                                                        

Requirement Value

Quality Clean, dry, compressed

Flow rate and pressure 1.2 Lps at 0.55 MPa (2.5 cfm at 80 psi) 

Operating Specification

Pollution degree 2

Installation category II

Temperature 4–40 °C

Humidity 10–90% RH, non-condensing

Altitude 1–2000 m

http://www.agilent.com/chem/askb
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Consumables

The Microplate Labeler uses thermal transfer ribbon and adhesive labels. Your 
shipment includes the Agilent Media Kit, which contains a one-to-one quantity of the 
ribbon and labels so that you can replace them at the same time. The kit also contains 
a pen for cleaning the printhead and an empty spool to take up the used ribbon.

Related topics

Connecting the air tubing: non-metric 

About this topic

For non-metric-based installations, such as those in the U.S., this topic explains how to 
connect the air tubing to the Microplate Labeler.

Before you begin

WARNING
To avoid injury, turn off the air supply before installing your Microplate Labeler. 
When air is flowing, air tubing can injure you if it whips around and strikes you. If you 
have not been trained in the correct way to handle air tubing, contact your facilities 
department.

CAUTION
Make sure that the air tubing coming into your Microplate Labeler is properly filtered 
for moisture. Moist air might shorten the life of your device. If the quality of your air 
supply is in question, contact Agilent  Automation Solutions Technical Support.

Locate the air connection kit (non-metric), including tubing and fittings, provided with 
your device.

Connection procedure

To set up a direct connection, use the following procedure. If you have another device 
connected to the air supply, use the supplied quick-release T-connector to connect to 
the existing air tubing.

For information about... See...

How to install the device “Installation workflow” on page 30

How to install the software Software release notes

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 137
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Figure Connection panel: orange air-supply port (left) and pressure gauge (right)

To install the air tubing:
1 Cut the supplied 1/4-inch tubing to the required length.
2 If your air supply uses a threaded connection at the supply end, attach the 1/4-inch 

NPT fitting to the connection.
3 Plug one end of the tubing into your lab’s air supply.
4 Connect the tubing from the air source to the long end of the toggle switch 

assembly. Connect the short end of the toggle switch assembly to the tubing that 
connects to the Microplate Labeler.

5 Push the other end of the 1/4-inch tubing into the orange quick-release air-supply 
port at the back of the Microplate Labeler. 

6 Test the installation by gently tugging the air tubing.
If you feel resistance, the line has been installed properly.

Related topics

For information about... See...

How to install the device “Installation workflow” on page 30

Site requirements for installation “Laboratory requirements” on page 31

How to connect air tubing for metric-
based installations

“Connecting the air tubing: metric” on 
page 36

Setting the air pressure “Setting the air pressure” on page 38

Disconnecting air supply “Disconnecting the air tubing” on page 123
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Connecting the air tubing: metric 

About this topic

This topic explains how to connect the air tubing to the Microplate Labeler for metric-
based installations. 
To make the Microplate Labeler compatible with your lab’s air system, you connect the 
supplied 6-mm air tubing to the Microplate Labeler air supply port. This topic describes 
how to make this connection.

Figure Connection panel: orange air-supply port (left) and pressure gauge (right)

Before you start

WARNING
Turn off the air supply at the source before installing the Microplate Labeler. If you 
have not been trained in the correct way to handle air tubing, contact your facilities 
department or Agilent Automation Solutions Technical Support for assistance.

CAUTION
Make sure that the air coming into the Microplate Labeler is dry and free of 
impurities, such as oil, which can damage the Microplate Labeler. If you have any 
questions about air quality, contact Agilent Automation Solutions Technical 
Support.

Locate the air connection kit (metric), including tubing and fittings, provided with your 
device.

Connection assembly

The metric fittings kit contains an adapter. 

Figure Connection to Microplate Labeler using adapter
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Procedure

The following procedure is used to set up a direct connection. If you have another 
instrument connected to the house air supply, you can use the supplied T-connector to 
connect into the existing air tubing.

To connect the metric fittings adapter:
1 Push one end of the nipple (white plastic tube) into the 1/4-inch side (red side) of 

the adapter.
2 Push the other end of the nipple into the air input port on the Microplate Labeler.
3 Push the 6-mm tubing into the blue side of the adapter.

CAUTION
Attempting to use tubing that has a different diameter can damage the adapter.

4 Gently pull on the air tubing to ensure that the assembly is connected properly.
 

Related topics

For information about... See...

How to install the device “Installation workflow” on page 30

Site requirements for installation “Laboratory requirements” on page 31

How to connect air tubing for North 
America

“Connecting the air tubing: non-metric” on 
page 34

Setting the air pressure “Setting the air pressure” on page 38

Disconnecting air supply “Disconnecting the air tubing” on page 123

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 137
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Setting the air pressure

About this topic

This topic describes how to set the air pressure after connecting the air tubing to the 
Microplate Labeler.

Procedure

To set the air pressure:
1 Turn on the air supply to the Microplate Labeler.

Depending on your lab configuration, the mechanism for turning on the air supply 
might be a pressure regulator located on the wall or on a compressed air cylinder, 
or a toggle switch on the air line. The air supply to the Microplate Labeler should be 
in the range of 0.55 MPa (80 psi) to 0.58 MPa (85 psi).

2 To adjust the internal air-pressure regulator on the Microplate Labeler:
a On the back of the applicator, pull out the pressure regulator knob until you 

feel a click.
b While watching the pressure gauge, turn the knob to increase or decrease the 

pressure so that the gauge reads in the following range:
0.55 MPa (80 psi) to 0.58 MPa (85 psi)

c Push the knob back in.

Figure Connection panel: air pressure gauge (top) and pressure regulator knob (bottom)

IMPORTANT
Check the air pressure after using the Microplate Labeler for the first time to make 
sure the air pressure setting is correct.
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Related topics

Connecting the power cord

About this topic

This topic explains how to connect the Microplate Labeler to a power source.

Before you start

WARNING
The Microplate Labeler has moving parts. Keep clothing, hair and jewelry away from 
it at all times.

Procedure

To install the power cord:
1 On the back of the Microplate Labeler applicator, ensure that the power switch is 

set to off (o).

For information about... See...

How to install the device “Installation workflow” on page 30

Site requirements for installation “Laboratory requirements” on page 31

Connecting the air tubing “Connecting the air tubing: non-metric” on 
page 34
“Connecting the air tubing: metric” on 
page 36

Disconnecting air supply “Disconnecting the air tubing” on page 123

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 137
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Figure Connection panel: AC power port and power switch

2 Plug one end of the power cord into the AC power port on the connection panel. 
3 Plug the other end of the power cord into an appropriate, grounded electrical 

socket.
Later, after you connect the computer, you will start up the device.

Related topics

For information about... See...

Connecting the computer “Connecting the device to the computer” on 
page 41

Turning on the device “Starting up and shutting down” on page 54

How to install the device “Installation workflow” on page 30

Site requirements for installation “Laboratory requirements” on page 31

Connection panel “Connection panel (back view)” on page 14

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 137
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Connecting the device to the computer

About this topic

This topic describes how to connect the computer to the Microplate Labeler using 
either of the following:
• Ethernet connection (recommended)
• Serial connection 

Using an Ethernet connection

You can use Ethernet to connect a Microplate Labeler to the computer using one of the 
following connections:
• Direct connection. A communication cable connects a single Microplate Labeler 

directly to a single host computer, where no other robots or devices must interact 
or communicate.

• Ethernet switch. An Ethernet switch connects the single cable from the computer 
to one or more cables that lead to one or more devices. If you are setting up a local 
area network (LAN) that has other devices on it, use an Ethernet switch.

The Agilent  configured computer has two Ethernet ports: 
• Port for the add-on Ethernet card. Configured for a static address. You connect the 

Microplate Labeler to the port configured for a static address. 
• Port for the computer’s built-in Ethernet card. Configured for a dynamic address. 

You can use this port to connect to your company network. 

To connect directly to the computer using Ethernet:
Connect one end of the Ethernet cable to the Ethernet port on the Microplate Labeler 
connection panel, and connect the other end of the cable to the Ethernet port of the 
computer.

Figure Connection panel: Ethernet connection
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To connect through an Ethernet switch:
1 Connect the switch to the computer as follows:

Note: If you are adding the Microplate Labeler to an existing LAN, this step 
should already be done.
a Connect the power cord to the switch.
b Connect one end of the Ethernet cable (black) into any Ethernet port on the 

switch, and connect the other end of the cable to an Ethernet port on the 
computer.

2 Connect the Microplate Labeler to the switch as follows:
a Connect one end of a second Ethernet cable to a port on the Ethernet switch.
b Connect the other end of the cable to the Ethernet port on the Microplate 

Labeler.

Connecting additional devices
You can connect additional Microplate Labelers to the network through the switch.
Each Microplate Labeler requires an additional profile.

IMPORTANT
Before connecting multiple Microplate Labeler devices on the same network, contact 
Agilent Automation Solutions Technical Support for guidance on setting the IP 
addresses.

About configuring the computer’s network card (Ethernet only)
The Agilent  configured computer is already set up to communicate with the 
Microplate Labeler. No change to the network card IP address is required.
If you are using a computer other than an Agilent  configured computer, make sure the 
value of the network card IP address and subnet mask are as follows:
• IP address: 192.168.0.1
• Subnet mask: 255.255.255.0
If your computer will be connected to your LAN, make sure the computer has a second 
network card. The second network card can have a dynamic IP address.

Using a serial connection

If you are connecting a single Microplate Labeler to a computer, you can use a serial 
connection.

CAUTION
Using serial connections to connect more than one Microplate Labeler to the same 
computer can cause problems with the barcode label formats.

To use a serial connection:
1 Connect one end of the supplied RS-232 DB-9 serial cable (beige) to a COM port on 

the computer.

IMPORTANT
The serial cable is a straight-through, pin-to-pin cable. Make sure you are not using a 
serial null-modem cable, which may look identical but will prevent proper 
communication with the Microplate Labeler.
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2 Connect the other end of the cable to the serial port on the Microplate Labeler 
connection panel.

Figure Connection panel: serial connection

To install the automation control software, see the software release notes, for 
example, the VWorks Automation Control Software Release Notes.

Related topics

For information about... See...

Changing the IP settings on a 
computer and on the Microplate 
Labeler

Agilent Automation Solutions Technical 
Support

How to install the device “Installation workflow” on page 30

Site requirements for installation “Laboratory requirements” on page 31

Connection panel “Connection panel (back view)” on page 14

Safety “Safety guidelines” on page 1

How to report a problem “Reporting problems” on page 137
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Loading labels and ribbon

About this topic

This topic describes how to load labels and ribbon in the Microplate Labeler printer. 
After you load the labels and ribbon, perform several print-and-apply tests to ensure 
that the labels are printing correctly and that the vacuum pads on the applicator head 
can pick the labels off of the label backing.
Note: If the Microplate Labeler is fitted with a cab SQUIX printer, you can go to the 
printer touchscreen Help menu to view videos showing how to load labels and ribbon.

Before you begin

Ensure that you have the Microplate Labeler Media Kit from Agilent Technologies. The 
kit contains a one-to-one quantity of ribbon and labels so that you can replace them at 
the same time. The kit contents are:
• Roll of labels (6,500)
• Thermal transfer ribbon 
• Empty ribbon core (functions as a spool to rewind the used ribbon)
• Cleaning pen

WARNING
The printhead can be hot after use. Allow the printhead to cool before changing the 
ribbon. 

Open the printer cover to gain access for loading the labels and ribbon.
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Figure Printer (side view) showing the feed paths of the ribbon (red) and labels (blue) 
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Removing the used ribbon

See the following figure for the component locations referenced in the procedure.

To remove the used ribbon:
1 While firmly grasping the ribbon supply hub (1), turn the green knob clockwise 

 to contract the hub and loosen the empty roll. Slide the roll off of the hub.

2 Lift the printhead lever (2) counterclockwise to lift the printhead.
3 While firmly grasping the take-up hub (3), turn the green take-up knob clockwise 

 to contract the hub and loosen the used roll of ribbon. Slide the used roll off 
of the take-up hub.

4 Lift the remaining ribbon out of the printer.

IMPORTANT
Clean the printhead before loading the new ribbon. See “Cleaning the printer 
components” on page 115.

                                                        

2

1

3
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Loading the new ribbon

See the following figure for the component locations referenced in the procedure.

To load new ribbon:
1 Install the new ribbon roll on the supply hub (1) as follows:

a While firmly holding the supply hub, turn the green knob clockwise  to 
contract the hub. Slide the new ribbon roll onto the hub until it is flush against 
the printer. Ensure the ribbon feeds clockwise with the coating facing 
downward when being unwound.

b While firmly holding the hub, turn the green knob counterclockwise  to 
expand the hub and secure the ribbon roll.

2 Ensure the printhead lever (2) is up to lift the printhead, and then guide the ribbon 
under and around the printhead.

WARNING
The printhead can be hot after use. Allow the printhead to cool before changing the 
ribbon. The printhead is the narrow bar that presses the image through the ribbon 
and onto the label as the media move onto the print roller.

CAUTION
Do not touch the protective glass layer of the printhead with your fingers. A dirty 
printhead will result in a poor print image.

3 Feed the ribbon onto an empty core on the take-up hub (3) as follows:

a While firmly holding the take-up hub, turn the green knob clockwise  to 
contract the hub. Slide an empty ribbon core onto the hub until it is flush 
against the printer. 

2

1

3
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b While firmly holding the hub, turn the green knob counterclockwise  to 
expand the hub and secure the ribbon core.

c Guide the ribbon under and then over the take-up hub so that it winds 
counterclockwise. Use adhesive tape to secure the end of the ribbon to the 
ribbon core. Make sure the edge of the ribbon is flush with the core against the 
printer.

4 Turn the ribbon take-up hub (3) counterclockwise to smooth out the ribbon slack.
If you are also loading labels, continue to the next procedure. If you are finished 
loading all media, turn the printhead lever (2) clockwise to lower the printhead.

Removing a used label roll

See the following figure for the component locations referenced in the procedure.

To remove a used label roll:
1 If the printhead is not already in the up position, lift the printhead lever (1) 

counterclockwise to lift the printhead.
2 Push down on the pinch-roller lever (2) to release the label strip.
3 Cut the used label strip, and wind it fully around the rewinder (3).

4 While firmly holding the rewinder (3), turn the green knob clockwise  to 
contract the rewinder and release the wound roll. 

5 Remove the wound roll. 
Note: You will remove the empty label core when you install the new label roll in 
the following procedure.

                                                        

1

2

3
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Loading the new labels

You install the labels in three basic steps:

Step 1. Installing the label roll on the roll retainer

To install the label roll on the roll retainer:

1 Turn the green locking ring (1) counterclockwise, so that the arrow points to .
2 Remove the margin stop (2).
3 On the roll retainer (3), load the new label roll so that it feeds counterclockwise with 

the label side up.
4 Reposition the margin stop (2) on the roll retainer (3).
5 While firmly pushing the margin stop against the label roll (4), turn the green 

locking ring (1) clockwise, so that the arrow points to , securing the label roll in 
position.

IMPORTANT
To ensure the roll feeds properly and label presentation is repeatable, the margin stop 
must be firmly in place against the label roll.

Step For this task...

1 Install the label roll on the roll retainer.

2 Feed the label strip under the printhead.

3 Secure the label strip to the rewinder.

1

3

2

4
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Step 2. Feeding the label strip under the printhead

To feed the label strip through the printhead:
1 Turn the printhead lever (5) counterclockwise to lift the printhead.
2 Slide the red guide ring (8) to the end of the axis bar.
3 Guide the label strip below the axis bar and through the label sensor (7) so that the 

label strip exits the print unit between the printhead and the print roller (6).
4 Push the guide ring (8) on the axis bar against the outer edge of the label strip.

5

7

6

8
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Step 3. Securing the label strip to the rewinder

To secure the label strip to the rewinder:
1 Push down on the pinch-roller lever (9) to lift the pinch roller off the rewind assist 

roller.
2 Guide the label strip down and under the rewind assist roller (10) toward the 

rewinder (11).

3 While holding the rewinder (11) firmly, turn the green knob clockwise  until it 
stops.

4 Insert the label strip under the three brackets on the rewinder (11), and turn the 
green knob counterclockwise  until it stops. The rewinder is fully expanded, 
gripping the label strip firmly. 
The inside edge of the label strip should be flush against the printer. 

5 Turn the rewinder (11) counterclockwise to tighten the label strip.
6 Push up on the pinch-roller lever (9) to position the pinch roller into position on the 

rewind assist roller.
7 Turn the printhead lever (12) clockwise to lower the printhead into position.
                                                        

12

10

9

11
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After you finish loading new ribbon and labels

Use Microplate Labeler Diagnostics to run a print-and-apply test and verify that the 
labels print correctly and the applicator head can pick up the labels from the printer. 
Optionally, you can reset the label counter in the I/O Functions tab to track the number 
of labels used.

Related topics

For information about... See...

Performing a print-and-apply test “Performing a print-and-apply test” on 
page 106

Resetting the label counter “Resetting the label counter in the 
Diagnostics software” on page 117

Cleaning the printhead and print roller 
using the cleaning pen

“Cleaning the printer components” on 
page 115

Routine printer maintenance “Routine maintenance” on page 102

Reporting problems “Reporting problems” on page 137
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4 Setting up the Microplate Labeler
This chapter describes how to perform the initial set up of the Microplate Labeler.
The topics are:
• “Starting up and shutting down” on page 54
• “Setup workflow” on page 56
• “Creating a VWorks device file” on page 58
• “Opening Diagnostics” on page 62
• “Creating a profile” on page 64
• “Initializing the device” on page 66
• “Placing a microplate on the plate stage” on page 68
• “About plate stage and applicator head positions” on page 69
• “Setting the plate stage vertical positions” on page 72
• “Setting the robot pickup angle teachpoint” on page 76
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Starting up and shutting down

About this topic

This topic describes how to start up and shut down the Microplate Labeler.

Starting up the device

IMPORTANT
Follow the steps in the order shown to establish communication with the Microplate 
Labeler.

To start up a Microplate Labeler
1 Turn on the air supply. 
2 On the Microplate Labeler connection panel, check the air pressure gauge (see 

figure, 1). Verify the air pressure is set within the following range: 
0.55 MPa (80 psi) to 0.58 MPa (85 psi)

Figure Connection panel showing Ethernet connection

3 Verify that the communication cable (2) and power cord (3) are connected, but do 
not turn on the power yet. 
Note: The figure shows an Ethernet connection. If you are using serial 
communication, the serial cable connects to the serial port. For more details, 
see “Connecting the device to the computer” on page 41.

4 If you are using an Ethernet switch, turn on the power to the Ethernet switch.
5 Turn on the computer and the monitor, and wait for the Microsoft Windows 

operating system to start.
6 On the connection panel, press the power switch (4) to the on (|) position.

1

2

3

4
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WARNING
The device components can move when you turn on the power and the air. Keep 
fingers, hair, clothing, and jewelry away from the Microplate Labeler while it is in 
motion. Never touch any of the moving parts or attempt to move labware while the 
Microplate Labeler is in operation. The device could pinch, pierce, or bruise you.

IMPORTANT
Ensure that the power switch on the printer remains in the on (|) position.

7 Start the automation control software, for example, start the VWorks software.
8 Initialize the device. For details, see “Initializing the device” on page 66.

Shutting down the device

Shut down the Microplate Labeler before you:
• Install a barcode reader
• Perform maintenance on or clean the Microplate Labeler
• Move the Microplate Labeler

To shut down the Microplate Labeler:
1 Exit the automation control software.
2 Shut down the computer and turn off the monitor.
3 On the Microplate Labeler connector panel, press the power switch to the off (o) 

position. 
4 Turn off the air supply.

Related topics

For information about... See...

Hardware components “Hardware overview” on page 12

Establishing communication with the 
Microplate Labeler

“Creating a VWorks device file” on page 58

Designing the label formats “Creating label formats” on page 79

Setting up and running a labeling 
protocol in the VWorks software

VWorks Automation Control User Guide

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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Setup workflow 

About this topic

This topic provides an overview of the procedures required to set up the Microplate 
Labeler after the device has been installed. If the Microplate Labeler is being set up for 
the first time, use the workflows described below. If the device is part of an integrated 
Agilent Technologies laboratory automation system, the setup has already been 
performed, and additional setup should not be required. 

Workflow

The following workflow describes the steps for initial setup of a Microplate Labeler 
when it is integrated in a lab automation system. 
Note: If the Microplate Labeler is integrated in a third-party lab automation system, the 
third-party software controls the device via the Microplate Labeler ActiveX interface. 
See the Microplate Labeler ActiveX User Guide. For additional information, see the 
third-party system documentation. For assistance, contact Agilent Automation 
Solutions Technical Support.

After the device setup is completed, you are ready to:

Step For this task... See...

1 Start up the Microplate Labeler. “Starting up and shutting down” on page 54

2 VWorks software only. Create a device file, 
add the Microplate Labeler device, and set 
the device properties.

“Creating a VWorks device file” on page 58

3 Start Microplate Labeler Diagnostics. “Opening Diagnostics” on page 62

4 Create a profile and initialize the device in 
Diagnostics.

• “Creating a profile” on page 64
• “Initializing the device” on page 66

5 Use Diagnostics to perform a print and apply 
test.

“Performing a print-and-apply test” on page 106

6 If necessary, adjust the plate stage height. “Setting the plate stage vertical positions” on 
page 72 

7 If applicable, verify the teachpoint for the 
robot pickup angle. If required, edit the 
teachpoint and update the profile.

“Setting the robot pickup angle teachpoint” on 
page 76

8 Perform a print and apply test. “Performing a print-and-apply test” on page 106

9 To set up additional Microplate Labeler 
devices, perform steps 2 through 8 for each 
additional device.
Note: You must create a profile with an 
appropriate Ethernet or serial setting for each 
device.

–
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• Design your label formats
• Set up a labeling protocol using the VWorks Print and Apply task.

Related topics

For information about... See...

Designing label formats “Creating label formats” on page 79

Creating and running a labeling 
protocol in the VWorks software

VWorks Automation Control User Guide

Starting up the device “Starting up and shutting down” on page 54

Reporting problems “Reporting problems” on page 137



4   Setting up the Microplate Labeler
Creating a VWorks device file

58 G5581A Microplate Labeler User Guide

Creating a VWorks device file

About this topic

Read this topic if you are an administrator responsible for managing Agilent 
Technologies devices that are controlled by the VWorks software. This topic describes 
how to add and delete new Microplate Labeler devices in the VWorks software. 
The VWorks software uses the information in a device file to communicate with and 
operate devices within the lab automation system. 
• If your computer was configured by Agilent Technologies. The correct device 

configuration is already set up for communication with the Microplate Labeler. 
You are not required to create a new Microplate Labeler device in the software 
unless you want to reference different profiles. To establish communication, you 
must initialize the device.

• If you configured your own computer. You must add a device in the VWorks 
software for each Microplate Labeler in the system.

For detailed information about device files and associations with profiles, teachpoints, 
and labware definitions, see the VWorks Automation Control User Guide. 

Devices and device files defined

A device is an item in your lab automation system that has an entry in a VWorks 
software device file. A device can be a robot, an instrument, or a location in a lab 
automation system that can hold a piece of labware.
The device file (*.dev) stores information for all the devices in an integrated system, 
including:
• Type of device (for example, Microplate Labeler device)
• Device configuration information (for example, approach height, allowed or 

prohibited labware, and so on)
• Profile to use

Creating a device file

If you are setting up the Microplate Labeler for the first time, you will create a device 
file. You add the Microplate Labeler device and the external devices to the device file.

To create a device file:
1 Log in to the VWorks software as an Administrator.
2 In the VWorks window, choose File > New > Device. 

A Device File tab appears in the VWorks window.
3 Choose File > Save. In the Save As dialog box, type a file name (*.dev), select the 

following storage location, and click Save:
…\VWorks Workspace\Device Files
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Adding the Microplate Labeler to a device file

Before you begin:
• Ensure that any devices are physically networked to the computer.
• Turn on the devices.

To add devices to a device file:
1 In the VWorks window, verify that the correct device file is open.

To open a device file, choose File > Open. In the Open dialog box, select your device 
file (*.dev), and then click Open. The device files should be stored in the following 
location:
…\VWorks Workspace\Device Files

2 In the Available Devices area, double-click the Microplate Labeler icon. Or, drag the 
Microplate Labeler icon to the Device File tab.
Note: To show or hide the list of available devices, choose View > Available 
Devices.
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3 In the Device File tab, select the Microplate Labeler-n icon.
4 Under Microplate Labeler Properties, type a Name for the device. By default, the 

software assigns Microplate Labeler-n, and increments the number for each 
Microplate Labeler device that you add.
To identify the specific Microplate Labeler, the device name should include the 
device serial number.

5 In the Profile list, select a profile for the device.
If the Profile list is empty, open Diagnostics and create a profile. Then return to the 
Profile list under Microplate Labeler Properties and select the new profile.

IMPORTANT
To use different configurations of the same device in different protocols, you can save 
time by creating a different device file for each configuration. For example, if you 
change a pipette head on a pipettor, you can simply open the device file that contains 
the device with the appropriate profile instead of editing the profile selection in the 
device file.

6 On the Device File tab, under the Microplate Labeler device icon, click the location 
icon. The corresponding properties appear.
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Set the desired values for the following properties. Use the default values for the 
remaining properties.

7 Select File > Save.
If you are creating a new device file, the Save As dialog box appears so that you 
can specify a name and location for your device file. Ensure the file type is *.dev.
Alternatively, you can select File > Save All to save the device file and the current 
protocol file at the same time.

                                                         

Property Description
 
Allowed/prohibited 
labware

Optional. Click  if you want to specify labware 
restrictions for this location. The Allowed/prohibited 
labware dialog box appears. For details on the labware 
classes, see the VWorks Automation Control Setup Guide.

Note: If the  button is not visible, click the empty field. 
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Related topics

Opening Diagnostics

About this topic

You use Microplate Labeler Diagnostics to set up and troubleshoot the device. This 
topic describes how to open Microplate Labeler Diagnostics from the VWorks 
software. 
Note: For information on how to access Microplate Labeler Diagnostics using the 
ActiveX control, see the Microplate Labeler ActiveX User Guide.

Opening Diagnostics from the VWorks software 

To open Microplate Labeler Diagnostics from the VWorks software:
1 In the VWorks software window, ensure the correct device file is open. 

To open a device file, choose File > Open, and then select the appropriate device 
file (*.dev) in the Open dialog box.

2 In the Devices area of the opened device file tab, highlight the device icon, and then 
click Device diagnostics.
The Microplate Labeler Diagnostics window appears.

For information about... See...

Setup workflow “Setup workflow” on page 56

Profiles “Creating a profile” on page 64
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Figure Microplate Labeler Diagnostics

Related topics

For information about... See...

Establishing communication with the 
device

“Creating a VWorks device file” on page 58

Profiles “Creating a profile” on page 64

Designing label formats “Creating label formats” on page 79

Setting up and running a VWorks 
labeling protocol

VWorks Automation Control User Guide

ActiveX controls Microplate Labeler ActiveX User Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Creating a profile 

About this topic

A profile contains the initialization settings associated with a particular device that are 
required for communication. Every Microplate Labeler on a given network requires its 
own profile. 
This topic describes the following procedures:
• “Creating a profile” on page 65
• “Initializing the device in diagnostics” on page 66

Before you begin

CAUTION
Each profile can be used by multiple protocols. Deleting, renaming, or changing the 
parameters for a profile based on one protocol can invalidate other protocols that 
use the profile.

CAUTION
The plate stage teachpoints are associated with a specific device profile. If you 
delete the profile, the teachpoints are also deleted. 

Ensure that Microplate Labeler Diagnostics is open. If it is not yet open, see “Opening 
Diagnostics” on page 62.

Figure Microplate Labeler Diagnostics—Profiles tab 
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Creating a profile

To create a profile:
1 In the Profiles tab, do one of the following:

• Click Create a new profile. In the Create Profile dialog box, type the name for the 
new profile, and then click OK.

• Select a profile to use as a template, and then click Create a copy of this profile. 
To rename the copy, click Rename this profile. 

2 Select one of the following communication connections:
a Serial. Select Serial connection, and then select which computer COM port to 

use for the connection. Go to step 4.
b Ethernet. Select Ethernet connection, and then click Select Microplate Labeler. 

Proceed to step 3.
3 Ethernet connection only. In the Discovered BioNet Devices dialog box, do the 

following:
a Click the Select the Ethernet adapter to use from the list below, and select the 

correct adapter for the device connection.
b In the list of devices that appear, select the Microplate Labeler device. If 

multiple Microplate Labeler devices are on the network, use the MAC Address 
to identify the Microplate Labeler device for this profile. 
To successfully communicate with the Microplate Labeler device, the Status 
column must display New or Matched.

c Click OK.

4 In the Printer type list, ensure that the cab option is selected. The Microplate 
Labeler has a cab thermal printer.

5 If the optional barcode reader is installed, select Verify barcodes after 
PrintAndApply.

6 To save the profile, click Update this profile.
Note: You can use the default values for the remaining profile settings. For a 
description of each parameter, see “Profiles tab” on page 160.
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Related topics

Initializing the device 

About this topic

To establish communication between the computer and the Microplate Labeler, you 
initialize the Microplate Labeler device. You can initialize the Microplate Labeler in the 
following ways:
• Microplate Labeler Diagnostics. To control the Microplate Labeler using Microplate 

Labeler Diagnostics, initialize the profile in Microplate Labeler Diagnostics.
• VWorks window. When you open a protocol or device file, a Would you like to 

initialize the devices now? message appears, and enables you to initialize the 
associated devices. 
You can also initialize the device in the VWorks device manager.

Initializing the device in diagnostics

If you want to control the device using Microplate Labeler Diagnostics, you initialize the 
profile in diagnostics. 
Note: For details on how to initialize the device using the ActiveX control, see the 
Microplate Labeler ActiveX User Guide.

To initialize a profile in Microplate Labeler Diagnostics:
1 In the Profiles tab, select the profile from the Profile name list.
2 Click Initialize this profile.

For information about... See...

Setup workflow “Setup workflow” on page 56

Microplate Labeler Diagnostics • “Opening Diagnostics” on page 62
• “Quick reference to Diagnostics 

software” on page 139

Designing label formats “Creating label formats” on page 79

Setting up and running a VWorks 
labeling protocol

VWorks Automation Control User Guide

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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Figure Initialize this profile in the Profiles tab

The Initialize this profile button label changes to Close this profile, as the following 
figure shows.

Figure Initialized profile in the Profiles tab
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Initializing the device in the VWorks device manager

To initialize the device in the VWorks device manager:
1 In the VWorks window, ensure that the device file is open and the Microplate 

Labeler device icon appears in the Devices area.
2 In the Devices area, select the Microplate Labeler device, and then click Initialize 

selected devices.

Related topics

Placing a microplate on the plate stage

About this topic

This topic explains how to place a microplate on the plate stage manually.

Procedure

To place a microplate on the plate stage:
1 Orient the microplate so that the A1 well is in the far left corner, matching the A1 

label on the plate stage.
2 Carefully lower the microplate onto the stage, making sure that the microplate lies 

flat.

For information about... See...

Setup workflow “Setup workflow” on page 56

Microplate Labeler Diagnostics • “Opening Diagnostics” on page 62
• “Quick reference to Diagnostics 

software” on page 139
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When the microplate is on the plate stage, the sides of the microplate are referred 
to as north, south, east, and west as the figure shows.
Note: If you purchased a standalone Microplate Labeler and later decide to 
integrate the device with a BenchCel Workstation, a different type of plate stage 
may be required. Contact Agilent Automation Solutions Technical Support for 
more information.

Related topics

About plate stage and applicator head positions

About this topic

During operation, both the plate stage and applicator head move to various positions. 
This topic summarizes those positions and gives the background information required 
for the following procedures:
• “Setting the plate stage vertical positions” on page 72
• “Setting the robot pickup angle teachpoint” on page 76

Plate stage teachpoints

The following plate stage positions are called teachpoints: 
• Robot pickup angle. Specifies the position that the plate stage returns to when a 

print-and-apply cycle is completed.
• Apply angle (east). Specifies the teachpoint position to which the plate stage 

rotates so that the east side faces the applicator head.
• Read angle (east). Specifies the teachpoint position to which the plate stage 

rotates so that the east side faces the optional barcode reader. 

Applicator head positions

The applicator head rotates to the printer to pick up a label, and rotates to the plate 
stage to apply a label. If the applicator head is out of alignment with either the printer 
or the plate stage, contact Agilent Automation Solutions Technical Support.

For information about... See...

Next step in the setup workflow “Setup workflow” on page 56

Selecting labware “Labware considerations” on page 22

Plate stage and applicator head 
positions

“About plate stage and applicator head 
positions” on page 69
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Positions summary

The following table summarizes the positions of the plate stage and applicator head at 
various points in a print-and-apply cycle.

Device Top View Point in 
Cycle

Plate Stage 
Position

Applicator Head 
Position

Start Factory-set home 
position.

Factory-set 
position pointing 
towards the 
printer

During 
microplate 
placing and 
pickup 

At the robot pickup 
angle teachpoint.
The default robot 
pickup angle value 
is 0.

Factory-set 
position pointing 
towards the 
printer

As a label is 
applied

At the apply angle 
teachpoint (with 
east side of stage 
towards the 
applicator head) 
and at one of two 
heights defined by 
the drop stage 
value.
The default angle 
value is 349, 
approximately.

Pointing towards 
the plate

As a barcode 
is read

At the barcode 
angle teachpoint, 
with the east side 
oriented towards 
the optional 
barcode reader 
mounted to the 
side of the printer.
The default angle 
value is 259, 
approximately.

Pointing towards 
the printer
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Related topics

For information about... See...

The general steps in the labeling 
process

“How the device applies a label” on page 27

Setup workflow “Setup workflow” on page 56

Setting the top and bottom positions 
of the plate stage

“Setting the plate stage vertical positions” 
on page 72

Adjusting the robot pickup angle “Setting the robot pickup angle teachpoint” 
on page 76

Moving the plate stage “Using plate stage controls in Diagnostics” 
on page 109

Applicator head and plate stage “Checking the basic applicator functions” 
on page 104
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Setting the plate stage vertical positions

About this topic

The Microplate Labeler accommodates a wide range of microplates, including deep-
well microplates, full-skirt PCR microplates, and tube racks. For details on supported 
labware, see “Labware considerations” on page 22. 
The Microplate Labeler plate stage enables labeling at two vertical positions: top and 
bottom. You can adjust automatically to the top or bottom position to accommodate 
labware with special requirements, such as tall microplate skirts. The top and bottom 
positions are set at the factory for the most commonly used microplate sizes. This 
topic explains how to change the top and bottom positions if necessary.

When to change the vertical plate stage position

To accommodate different microplates sizes and skirt heights, you can adjust the top 
and bottom plate stage positions. Different types of microplates can have different 
skirt heights. A label positioned at the optimal height on one microplate will be either 
too high or too low on a microplate that has a significantly different skirt height.

Figure Examples of label positions of different sizes of labware

For shallow microplates, you might set the plate stage in the top position. For 
microplates with tall skirts, you might have to drop the plate stage to the bottom 
position. If you are using both types of microplates, you can use a different position for 
each.
You set the plate stage top and bottom positions mechanically. In the software, you 
specify whether the top or bottom position is used to label a specific microplate. 
Before labeling a microplate, the plate stage moves to the vertical position specified by 
the labware definition (VWorks software) or the schema (ActiveX).

Plate spacer

The Microplate Labeler is shipped with a plate spacer installed. If you are using a 
microplate that cannot be labeled properly through adjustment of the plate stage 
height, you can remove the plate spacer. When the plate spacer is removed, labels can 
be placed 0.635-cm (0.25-in) higher on the microplate, but the adjustment also affects 
how close to the bottom of the microplate a label can be placed. For more information, 
contact Agilent Automation Solutions Technical Support.
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Plate stage positions for microplates of the same height

If all of the microplates that use have the same skirt height, you can set the top and 
bottom positions to the same height. This enables you to determine if one of the stage 
height positions has drifted. If any vertical movement occurs in the plate stage when 
you use the drop stage command in Microplate Labeler Diagnostics, drift has 
occurred.

Before you start

• Open Microplate Labeler Diagnostics. For details, see “Opening Diagnostics” on 
page 62.

• Locate a 2.5-mm hex wrench.

Procedures

The top and bottom heights of the plate stage are determined by mechanical stops 
that you position by turning the following set screws located near the plate stage:
• UP sets the top position.
• DOWN sets the bottom position.

Figure Plate stage adjustment set screws (UP and DOWN)

The procedures for setting the top and bottom positions are given separately.

Setting the top position

To set the top position of the plate stage:
1 Place the microplate that you want to use at the top position on the plate stage.
2 In Microplate Labeler Diagnostics, click the Stage Setup tab.
3 Under Teachpoints, locate Apply angle (east side), and click Move here to move the 

plate stage to the apply angle teachpoint.
4 Click the I/O Functions tab, and click Raise stage, if necessary, to move the plate 

stage to the top position.
5 To check the top position: 

a In the I/O Functions tab, click Rotate to stage, and then click Extend head to 
extend the applicator head.

b Examine the alignment between the application head vacuum pads and the 
side of the microplate. 

UP        DOWN
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Your goal is to position the vacuum pads at the desired height of the label on 
the microplate. 

c Click Retract head, and then click Rotate to printer to move the applicator head 
out of the path of the plate stage.

If the height appears to be correct, go to step 8 to home the stage and run a print-
and-apply test. If the position requires adjustment, go to step 6.

6 Select the Disable stage auto-repositioning check box, and then manually rotate the 
plate stage to gain access to the UP and DOWN set screws.

7 Insert the 2.5-mm hex wrench into the UP set screw. Turn counterclockwise to 
raise the plate stage, or turn clockwise to lower the plate stage.
Raise or lower the plate stage based on how much you want the label to move 
from where it has been placed.

8 In the Stage Setup tab, click Home stage.
9 To check the position:

a In Microplate Labeler Diagnostics, click the Testing tab.
b Select Print and apply, and then click Run test. 

10 Examine the vertical alignment of the label on the microplate. 
If necessary, repeat step 5 to step 8 until the adjustment is correct. After adjusting 
the top position, use the following procedure to check the bottom position.

Setting the bottom position

To set the bottom position of the plate stage:
1 Place the microplate that you want to use at the lower position on the plate stage.
2 In the Stage Setup tab, locate Apply angle (east side), and click Move here to move 

the plate stage to the apply angle teachpoint.
3 Click the I/O Functions tab, and click Drop stage, if necessary, to move the plate 

stage to the bottom position.
4 To check the bottom height position:

a Click Rotate to stage, and then click Extend head to extend the applicator head.
b Examine the alignment between the application head vacuum pads and the 

side of the microplate. 
Your goal is to position the vacuum pads at the desired height of the label. 

00173

UP        DOWN
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c Click Retract head, and then click Rotate to printer to move the applicator head 
out of the path of the plate stage.

If the position appears to be correct, go to step 7 to run a print-and-apply test. If 
the position requires adjustment, proceed to step 5.

5 Ensure the Disable stage auto-repositioning check box is selected. Manually rotate 
the plate stage to gain access to the UP and DOWN set screws.

6 Insert the 2.5-mm hex wrench into the DOWN set screw. Turn clockwise to raise 
the plate stage, and turn counter-clockwise to lower the plate stage. 

7 In the Stage Setup tab, click Home stage.
8 To check the position:

a In Microplate Labeler Diagnostics, click the Testing tab.
b Select Print and apply, and then click Run test. 

9 Examine the vertical alignment of the label on the microplate. 
If necessary, repeat step 4 to step 8 until the adjustment is correct.

10 Ensure that the Disable stage auto-repositioning check box is clear (not selected).

About automatically adjusting the stage height during a run
The procedure for setting the plate stage height parameter varies depending on which 
software you use to control the Microplate Labeler:

Related topics

Automation control software See…

VWorks software. In the labware definition of a 
microplate that uses the plate stage bottom 
position, select the option to lower the plate at the 
Microplate Labeler. This parameter is in the 
Labware Editor—Plate Properties tab.

VWorks Automation Control 
Setup Guide

ActiveX. When setting up a print schema, set the 
dropStage parameter to TRUE (bottom position) or 
FALSE (top position).

Microplate Labeler ActiveX 
User Guide

For information about... See...

Starting Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Setup workflow “Setup workflow” on page 56

Moving the plate stage “Using plate stage controls in Diagnostics” 
on page 109

How to resolve problems “Reporting problems” on page 137

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Setting the robot pickup angle teachpoint

About this topic

The robot pickup angle is the position that the plate stage returns to after a print-and-
apply cycle is completed. The teachpoint for the robot pickup angle is set at the 
factory. 
If your Microplate Labeler is: 
• A standalone device, this teachpoint should not require adjustment. 
• Integrated in a BenchCel Workstation, this teachpoint is already set for you. 
• Integrated in a third-party lab automation system, this teachpoint might require 

adjustment to accommodate your robot’s geometry.
This topic explains how to adjust the robot pickup angle and set the teachpoint so that 
a robot can deliver or pick up a microplate from the plate stage.

CAUTION
The Apply angle (east) and Read angle (east) teachpoints are set at the factory. Do 
not attempt to set these teachpoints. If you think either of these two teachpoints 
require adjustment, contact Agilent Automation Solutions Technical Support.

Viewing the robot pickup angle

The Stage Setup tab in Microplate Labeler Diagnostics displays the teachpoint 
settings.

To view the robot pickup angle:
1 Ensure that the Microplate Labeler device is initialized. For the VWorks software, 

see “Initializing the device in the VWorks device manager” on page 68.
2 Open Microplate Labeler Diagnostics.
3 Click the Stage Setup tab.



77

4   Setting up the Microplate Labeler
Setting the robot pickup angle teachpoint

G5581A Microplate Labeler User Guide

4 Under Teachpoints, check the value for the Robot pickup angle.

Two methods for setting the robot pickup angle

You can use either of the following procedures for setting the robot pickup angle:
• Specify an angle in the Angle value box or the Angle increment box.
• Manually move the plate stage to a position and then set its position as the 

teachpoint.

Specifying a new angle

To set the robot pickup angle by specifying the angle:
1 Ensure the device is initialized, and Microplate Labeler Diagnostics is open.
2 Ensure that the applicator head is pointing towards the printer. 

If necessary, click the I/O Functions tab, and then click Rotate to printer. The 
applicator head rotates towards the printer, moving it out of the plate stage 
rotation path.

3 Under Stage Controls, type a value in the Angle value box, and then click Move to.
Alternatively, type a value in the Angle increment box, and then click Rotate CCW or 
Rotate CW. 

4 If the position is correct, under Teachpoints, locate Robot pickup angle, and then 
click Teach.

5 In the Profiles tab, click Update this profile.

Manually moving the plate stage

To set the robot pickup angle by manually moving the plate stage:
1 Ensure the device is initialized, and Microplate Labeler Diagnostics is open.
2 Ensure that the applicator head is pointing towards the printer. 

If necessary, click the I/O Functions tab, and then click Rotate to printer. The 
applicator head rotates towards the printer, moving it out of the plate stage 
rotation path.

CAUTION
Before moving the plate stage, make sure that the applicator head is not in the path 
of the plate stage.

3 Click the Stage Setup tab, and select Disable stage auto-repositioning.
4 Manually rotate the plate stage to the desired position.
5 Under Teachpoints, locate Robot pickup angle, and then click Teach.
6 Clear the Disable stage auto-repositioning check box.
7 In the Profiles tab, click Update this profile.
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Related topics

For information about... See...

Microplate Labeler Diagnostics • “Opening Diagnostics” on page 62
• “Quick reference to Diagnostics 

software” on page 139

Plate stage positions “About plate stage and applicator head 
positions” on page 69

Designing label formats “Creating label formats” on page 79

Setting up and running a labeling 
protocol

VWorks Automation Control User Guide
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5 Creating label formats
The Microplate Labeler includes templates for label formats that are ready to use or 
that you can customize. For an overview of the templates, see “Templates for 
barcode formats” on page 165. This chapter describes the label formats and how to 
create them and customize the templates.
The topics are:
• “About label formats and content” on page 80
• “Creating and editing label formats” on page 84
• “Changing the field size and other attributes” on page 92
• “Removing unwanted label format data” on page 96
• “Barcodes and supported symbologies” on page 97
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About label formats and content

About this topic

This topic has the following sections:
• “Overview” on page 80
• “Label format” on page 80
• “Label format storage and uploading” on page 83
• “About specifying the label content” on page 83

Overview

To create a label, the software requires the following:

• Label format. The number and arrangement of fields on a label, and the field type, 
size, and other attributes. 
Each label printed by the Microplate Labeler contains up to six fields of data. Only 
one field can be a barcode field. The remaining fields can be human-readable text.

• Label content. The data that the software substitutes for the text and barcode 
fields in the label format when the label is printed.

When you run a labeling protocol using the VWorks software, the label format loads 
from the printer's memory. The software substitutes the data (label content) for the 
text and barcode fields in the label format, and then prints the label.

Label format

The Microplate Labeler contains a set of template label formats that are ready to use 
or that you can customize for your lab. For an overview of the templates, see 
“Templates for barcode formats” on page 165. 

Label format fields and label field data
A label format can consist of up to six label fields. Associated with every label field is a 
set of label field data that defines the following:
• Field type: human-readable text or barcode 
• Font family used for printing the human-readable text fields
• Barcode symbology used for text encoding if it is a barcode field
• Position of the field on the label
• Attributes of the field such as field size 
• Contents of the field for a test print from the Label Editor tab
The following figure shows an example of a label with two fields: one barcode field and 
one human-readable text field. 
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Figure Example label with Code 128 barcode field and human-readable text field

Label design considerations
If you want to design your own label format, consider the following parameters:
• Symbology encoding characteristics. Which characters does the symbology 

encode, for example, alphanumeric or numeric? What is the data density of the 
symbology? For instance, the Code 128 symbology can encode more data in the 
same space than the Code 39 symbology.

• Symbology size attributes. What size settings will you use for the narrow-bar width 
and the height of the bars in the barcode? What will the length and height of the 
barcode be? 
Smaller size attributes allow greater data density but decrease the readability of 
the symbol. In general, a 0.25 mm (0.01 in) narrow bar width offers very good 
readability. A narrow bar width smaller than 0.17 mm (0.067 in) will be very hard to 
read and should not be used.

• Font type and size for human-readable text. The Agilent templates use the Droid 
Mono Bold font, which Agilent Technologies recommends for most applications. 
The font size depends on the size of the other fields on the label. 
For example, the label in the preceding figure uses a 6-point font.

• Proportions of fields on the label. Increasing the size of the barcode symbol will 
improve readability of the symbol but reduce the amount of space left for other 
fields on the label. 
The example in the preceding figure shows a label where the barcode fills 
approximately 80% of the label area, while the human-readable field fills 
approximately 20% of the label area.

• Blank margins or white space. To ensure that the barcode reader can read a 
barcode, the label design should include the blank margins described in the 
following section.

Blank margins in the label design

The label design should include the following blank margins:
• Quiet zones. The barcode symbology requires quiet zones on each end to facilitate 

machine readability. The required size of the quiet zone can vary depending on the 
symbology. 
For example, the minimum quiet zone for Code 128 is 10 times the width of the 
narrowest bar or space in the barcode. In general, you should allow a 3.81 mm 
(0.15-inch) margin on both the right and left sides of a linear symbol to 
accommodate quiet zones and other factors.

                                                        

Blank margins (quiet zones)

5.08 cm (2 in)

0.635 cm (0.25 in)
Barcode

Human 
readable
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• Print drift allowance. Include blank space to compensate for horizontal and vertical 
drift between the print and the edges of the label, for example, as a result of the 
label media shifting relative to the printhead. 
– The vertical print drift should be no more than ±0.25 mm (0.01 in.).
– The horizontal print drift should be no more than ±0.75 mm (0.03 in.).

• Separator between fields. Although no print drift occurs between two fields, allow 
for some blank space between fields to facilitate readability.

Figure Minimum blank margins for Code 128 (top) and Data Matrix (bottom) symbologies

At a minimum, the required margin sizes on these two label designs are:

The Data Matrix symbology requires quiet zones on all sides of the barcode. The Data 
Matrix symbology features an L-shaped finder pattern on the left and bottom sides 
that serves to locate the start of the symbology, and a timing pattern (opposite the L 
shape) to indicate the symbology end for a barcode reader. 
                                                        

Quiet zone
Print drift, hoziontal
Print drift, vertical
Separator

Parameter 1D Code 128 symbology 2D Data Matrix symbology

Quiet zone Required on each end: 
2.5 mm (0.1 in)
10 * narrow bar width, where,
narrow bar width = 
0.25 mm (0.01 in)

Required on all sides: 
0.30 mm (0.0117 in)
1 * module width, where,
Module width (dot size) = 
0.30 mm (0.0117 in)

Print drift 
allowance, 
horizontal

On each end of the quiet zone: 
0.76 mm (0.03 in)

On each end of the side quiet 
zones: 0.76 mm (0.03 in)

Print drift 
allowance, 
vertical

Below bottom field on label: 
0.25 mm (0.01 in)

Above and below the top and 
bottom quiet zones: 
0.25 mm (0.01 in)

Separator 
between 
fields

0.25 mm (0.01 in) 2.5 mm (0.1 in)
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Label format storage and uploading

You use the Label Editor tab in Microplate Labeler Diagnostics to create and edit label 
formats, and to upload the label formats to the printer.
Label formats must be stored in the printer so that they are available for use. The 
printer can store up to 20 label formats. 
Label formats can also be saved in XML files. Before you can use a format that is 
stored in an XML file, you must first upload the label format to the printer.
To modify a label format, you load the format into the Microplate Labeler Diagnostics—
Label Editor tab. 

About specifying the label content

When configuring a VWorks labeling protocol, you select a predefined label format that 
has been loaded in the printer, and then specify the content for the fields that have 
been configured in that particular label format. The method for specifying the label 
content varies depends on which automation control software you use.

Related topics

Software that controls the device See...

VWorks software. You create a protocol that 
contains a Print and Apply task. You select the label 
format and field content when setting the task 
parameters.
Note: You set the plate stage height in the labware 
definition. You specify which sides of the microplate 
to label in the plate process parameters.

VWorks Automation Control 
User Guide 

ActiveX control. For a device integrated in a third-
party lab automation system, you can use the 
ActiveX controls to define the label format and 
content.

Microplate Labeler ActiveX 
User Guide

For information about... See...

Workflow for running an integrated 
Microplate Labeler using the VWorks 
software

“Overall setup workflow” on page 28

Barcode terminology and symbology “Barcodes and supported symbologies” on 
page 97

Customizing a label format template “Creating and editing label formats” on 
page 84

http://www.chem.agilent.com/Library/usermanuals/Public/G5404_90008_R00_MicroplateLabelerActiveX_UG_S_EN.pdf
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Creating and editing label formats

About this topic

The Microplate Labeler contains a set of template label formats that are ready to use 
or that you can modify. For an overview of the templates, see “Templates for barcode 
formats” on page 165.
This topic describes how to load a label format and then customize it to meet the 
requirements of your lab. 
For a description of label formats and content, see “About label formats and content” 
on page 80.

Before you start

The following workflow assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 62.
• The profile for your device is initialized. For details, see “Initializing the device in 

diagnostics” on page 66.

CAUTION
Changes that you make to a label format are kept in memory only. To avoid losing 
changes to a label format, you must upload the revised format to the printer or save 
the changes to an XML file before selecting a different label format or closing 
Microplate Labeler Diagnostics.

Workflow for creating or editing a label format

Step For this task... See...

1 Load a label format that you want 
to customize.

“Loading a label format in the Label 
Editor” on page 85

2 If desired, add additional fields to 
the label format by right-clicking 
the Label Editor preview box.

“Adding a field to a label format” on 
page 86

3 Edit the properties of a field. • “Editing the field properties” on 
page 87

• “Changing the field size and other 
attributes” on page 92

4 Repeat steps 2 and 3 for the 
other fields in the label.
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Loading a label format in the Label Editor

You can load the label format from the printer or from an XML file on the computer.
Note: The Microplate Labeler supports label formats developed for the cab A2+ printer 
only.

To load a label format from the printer:
1 In Microplate Labeler Diagnostics, click the Label Editor tab.
2 In the Current format list, select a format, and then click Load from printer. 

If the selected format has not been defined, the Label Field Data table and the 
Label Editor preview box are blank. Otherwise, data appear in the table, and a 
representation of the format appears in the Label Editor preview box. 

                                                        

5 Upload the edited label format to 
the printer.
Before a label format is available 
for printing, the format must be 
uploaded to the printer.
Optionally, save a backup copy to 
an XML file.

“Uploading and saving a format” on 
page 91.

6 Print a test label to check your 
changes.

“Printing a test label from the Label 
Editor tab” on page 92

Step For this task... See...
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Alternatively, you can load a label format from an XML file on the computer. 

To load a label format from an XML file:
1 In the Label Editor tab, click Load format from disk.
2 In the Open dialog box, navigate to the file storage location, select the XML file, and 

then click Open. 
By default, the label format templates are installed in the following folder:
C:\VWorks Workspace\Microplate Labeler Label Formats

Renaming a label format

To rename a label format:
1 In the Current format list, select the desired format and then click Rename format.
2 In the dialog box that appears, type the format name, and then click OK. The new 

name appears in the Current format list.

Adding a field to a label format

You can add up to six fields in the label. Only one field can be a barcode. The remaining 
fields can be human-readable text.

To add a field to a label format:
1 Ensure that the format you want to edit is loaded.
2 Right-click in the Label Editor preview box, and then choose one of the following 

from the shortcut menu:
• Insert text. Available for any field.

• Insert barcode. Available for field 2 only. 
Note: If you want the label to contain a barcode only, you can add a text 
field, add a barcode field, and then delete the text field.

The default data fills a row in the Label Field Data, and a corresponding field 
appears in the preview box.
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Editing the field properties

This section describes how to change the following field properties:
• Alias
• Value
• Format
• Position (x, y coordinates)
To change the field size and other attributes, see “Changing the field size and other 
attributes” on page 92.
To clear or remove data from the format, see “Removing unwanted label format data” 
on page 96.
For a quick reference to each column in the Label Field Data table, see “Label Editor 
tab” on page 144.

Assigning an alias to a field in the format

To assign an alias to a field in the label:
1 In the Label Field Data table, select the desired field (Index 1 to 6), and then click 

Rename field.
2 In the dialog box that appears, type a name, and click OK. The name appears in the 

Field Alias column for the selected field.
For example, you might change the alias from a number to the name, Date.

Changing the value

The value property that you specify in the Label Editor tab is used only when 
performing a test print from the Label Editor tab. When you run a labeling protocol 
using the VWorks software, the value of each field comes from the data source that 
you select in the VWorks software.
A field’s value parameter determines:
• Human-readable field. The actual text that is printed during a test print.
• Barcode field. The actual data that is encoded into the barcode for a test print. The 

barcode text should follow the rules of the specified symbology, for example, 
limited to numbers only or uppercase letters and numbers.
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To change the value:
1 In the Field Data Table, click the entry in the Value column for the field that you 

want to edit. The row is highlighted. 
2 Click the value once more to enable editing, and then type a new value that is 

about the same length as the text for the production labeling.

IMPORTANT
Ensure that the characters you enter for a barcode field are supported by the selected 
format (symbology).

Note: The Label Editor preview provides an approximate representation of the label 
layout. To view the actual field sizes and positions on the label, print a test label. 

Changing the format

A field format determines the printed appearance of a field. For example, the font 
selection for a text field or the symbology selection for a barcode field.

To change the format of a field:
1 In the Label Field Data table, click the name in the Format column for the field that 

you want to edit. The row is highlighted.
2 Click the format name once more to display the list, and then select the desired 

text font or barcode symbology. 
The list changes based on the field type (text or barcode).
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IMPORTANT
For barcode fields, make sure that the symbology you choose supports all of the 
characters in your field’s data. Also, if you are using a barcode reader, make sure that 
symbology you choose can be read by your barcode readers. For a description of the 
available symbologies for the Microplate Labeler, see “Barcodes and supported 
symbologies” on page 97.

Note: The Microplate Labeler supports label formats developed for the cab A2+ 
printer only. 

Positioning the fields on the label 

The Label Editor tab provides two methods for positioning the field on the label:
• Label Editor preview box. You can drag each field to an approximate position in the 

preview box. However, the preview is not precise, and you must test print the label 
to see the actual field sizes and positions, and then adjust as necessary. 

Figure Example of format in the preview box and printed label
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• X and Y columns. The X and Y values in the Label Field Data table correspond to 
the printer’s x- and y-coordinates for the label, where the origin is at the top left 
corner of the label.
– x-coordinate. The horizontal start position, the distance between the label’s left 

edge and the field’s left edge.
– y-coordinate. The vertical start position, the distance between the label’s top 

edge and the text field (bottom left corner) or barcode field (upper left corner).

To position the field’s starting point using the X and Y values, you calculate the position 
based on the following:
• Label size: 0.25 by 2.0 in (0.0635 by 5.08 cm)
• X and Y unit of measure: 0.001 in (0.0254 mm)

Given the label size, the value ranges are Y: 0 to 250, and X: 0 to 2000.
For example, suppose you want to create a label similar to the one in the following 
figure. In this example, the upper edge of the barcode field is flush with the label’s top 
edge, the barcode field has a blank margin (quiet zone) on each end to allow 
readability, and a text field is aligned on the left under the barcode field. The following 
table provides the X and Y values for the label in the figure.
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Figure Example barcode and text field positions on label

To use the X and Y columns to position a field:
1 In the Label Field Data table, click the value in the X column for the field that you 

want to edit. Click the value again to enable editing, and type the new value.
2 Click the value in the Y column for the field that you want to edit. Click the value 

again to enable editing, and type the new value.
In addition to the field’s x, y coordinates, the field size attributes affect the field’s 
placement on the label. Initially, you can use the default values in the Attributes 
column. You can upload the label format to the printer, print a test label, and then 
evaluate whether to adjust the size or placements of the fields.

Uploading and saving a format

After you have created or edited a label format, you must upload it to the printer before 
it can be used. You might also want to save it in an XML file on the computer, 
especially as label formats can be accidently overwritten. 

To upload a format to the printer:
1 In the Label Editor tab, click Upload format to printer.

To save a format to an XML file:
1 In the Label Editor tab, click Save format to disk.
2 In the Save As dialog box, specify the XML file name and the file storage location, 

and click Save.
Note: The software saves one label format per XML file.

Blank margins (quiet zones)

5.08 cm (2 in)

0.635 cm (0.25 in)
Barcode

Human 
readable

Field 
type

X, Y 
values

Position on label

Barcode X = 150 The field left edge is 0.150 in (0.38 cm) from the label left 
edge.

Y = 0 The field top edge is 0.0 in from the label top edge.

Text X = 150 The field left edge is 0.150 in (0.38 cm) from the label left 
edge.

Y = 230 The field bottom edge is 0.230 in (0.58 cm) from the label 
top edge.
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Printing a test label from the Label Editor tab

After you upload a label format to the printer, you can check your changes by printing a 
test label.

To print a test label:
1 In the Label Editor tab, click Print test label, or press the green button on the device.
Alternatively, you can perform test print-and-apply cycles using the Testing tab. See 
“Performing a print-and-apply test” on page 106.

Related topics

Changing the field size and other attributes

About this topic

When designing a label format, you can change the size of the fields to make the label 
more readable or to fit more information on the label. This topic describes how to alter 
the size of a printed text or barcode field.

Before you start

If you have not already done so, already:
• Load the label format that you want to modify. See “Loading a label format in the 

Label Editor” on page 85.
• Make sure you understand how the fields are positioned on the label. See 

“Positioning the fields on the label” on page 89.
• Consider the label size when planning the format: 0.0635 by 5.08 cm 

(0.25 by 2.0 in).

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Label format and label content “About label formats and content” on 
page 80

Performing a print and apply test “Performing a print-and-apply test” on 
page 106

Performing a test barcode read Documentation for your barcode reader

Setting the parameters for the label 
content

VWorks Automation Control User Guide
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IMPORTANT
If you increase the field size too much, the printed field may not fit on the label. If you 
decrease the field size too much, the printed field may not be readable. For example, 
barcode symbology that is too small may appear as a thin line of dots and dashes.

Changing the size attributes of a text field

To change the size attributes of a text field:
1 In the Label Field Data table, click the entry in the Attributes column for the field that 

you want to edit. The row is highlighted.
2 Click the attribute entry once more. The Edit Values dialog box opens.

3 In the Edit Values dialog box, type the values for the relevant parameters in the 
Sizing area, and then click OK. 
The available parameters change depending on the format selection.

Font type Parameter and description
Bitmap fonts: 
12x12, 16x16, 
16x32, OCR-A, 
OCR-B

• Horizontal magnification. Specifies the x-axis 
magnification of the text block.

• Vertical magnification. Specifies the y-axis 
magnification of the text block.

Range: 1–10
The magnification factors are multipliers, for example, a 
value of 2 is twice as big as 1.
The different bitmap fonts are different sizes at a 
magnification of 1. Therefore, the reasonable range of 
magnification values varies for each of the bitmap fonts. 
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Note: The Label Editor preview box does not reflect the size change. To see the 
effect, print a test label.

4 To check your changes, see “Checking the attribute changes” on page 95.

Changing the attributes of a barcode field

To change the attributes of a barcode field:
1 In the Label Field Data table, click the entry in the Attributes column for the field that 

you want to edit. The row is highlighted.
2 Click the attribute entry once more. The Edit Values dialog box opens.

3 In the Edit Values dialog box, type or select the values for the relevant parameters, 
and then click OK.

IMPORTANT
Make sure the barcode size allows for sufficient blank margins (quiet zones) on each 
end of the barcode to ensure readability by a barcode reader.

Vector fonts: Droid 
Mono, Droid Mono 
Bold, Swiss721, 
Swiss721Bold, 
Monospaced

• Point size. Specifies the height of the font in 0.01 in 
(0.0254 mm). For example, a 6-point font will be 0.06-
in (0.15 cm) tall. The width is scaled to match.

• Horizontal scaling (%). Allows you to make the font 
narrower or wider without changing the font height.

Font type Parameter and description

Parameter Description
Sizing Use the sizing parameters to change the barcode size. 
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4 Click Upload format to printer, and then check your changes using the following 
procedure.

IMPORTANT
Verify that your barcode reader can read the barcode in the label format before doing a 
production run.

Checking the attribute changes

To check the attribute changes:
1 In the Label Editor tab, click Print test label, or press the green button on the device.

If after increasing the size of the field, the field does not print, check where the field 
is positioned on the label. The field may now be positioned off the edge of the 
label.

IMPORTANT
The printer does not always scale barcodes and fonts consistently. If you change a 
text field’s magnification, always perform a test print to make sure that you can still 
read the text. If you change a barcode field’s magnification, perform a test read of the 
barcode using a barcode reader.

Saving the changes

You must upload the changed format to the printer before the revised or new label 
format is available for printing.

• Height Specifies the height of each bar in 0.001 in (0.0254 mm). 
The overall barcode width is scaled relative to this value. 
For example, if Height = 150, the barcode is 0.150-in (0.38-
cm) tall.

• Narrow bar 
width

Defines the width of the narrowest bar in the barcode in 
0.001 in (0.0254 mm). The overall barcode width is scaled 
relative to this value.

• Bar width ratio Defines the ratio between the narrow and wide bars in the 
barcode. For example, a ratio of 3 means that the wide bar 
is three times the width of the narrow bar.

• Row height Defines the height of a single row in a 2D symbology.
• Symbol 

aspect ratio
Defines the ratio between the height and width of the 
barcode. 

• Dot size Data Matrix only. Defines the size of the dot in the 2D code. 
The overall height and width of the barcode are scaled to 
this value.

• Columns Micro PDF417 only. Defines how many columns are used 
(1-4) to display the data. 
The column number combined with the narrow bar width 
sets the width of the symbol. The printer adds more rows 
of data (height to the symbol) as more characters are 
added.

Error level PDF417 only. Defines an error level.

Parameter Description
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To upload the format changes to the printer:
1 In the Label Editor tab, click Upload format to printer. 

To save the format changes to an XML file:
1 In the Label Editor tab, click Save format to disk. 
2 In the Save As dialog box, specify the file name and the file storage location, and 

click Save.

Related topics

Removing unwanted label format data

About this topic

This topic describes how to delete one or more fields from a label format or clear the 
label format entirely.

Before you start

If you have not already done so, complete the following steps:

For information about... See...

Designing label formats “Creating and editing label formats” on 
page 84

Performing a test print and apply 
operation

“Performing a print-and-apply test” on 
page 106

Performing a test barcode read Documentation for your barcode reader

Setting the parameters for the label 
content

VWorks Automation Control User Guide

Step Task See…

1 Open Microplate Labeler 
Diagnostics.

“Opening Diagnostics” on page 62

2 Ensure the profile for your device is 
initialized.

“Initializing the device in 
diagnostics” on page 66

3 In the Label Editor tab, load the 
label format that you want to 
modify.

“Loading a label format in the Label 
Editor” on page 85
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Deleting a field

To delete a field:
1 In the Label Editor tab, right-click the field in the Label Editor preview box.
2 In the shortcut menu that appears, choose Delete field.

Clearing a label

To clear a label of its contents:
1 In the Label Editor tab, right-click in the Label Editor preview box.
2 In the shortcut menu that appears, choose Clear label.
All of the data in the Label Editor tab disappears.

Related topics

Barcodes and supported symbologies

About this topic

This topic presents basic barcode concepts and provides examples of the supported 
symbologies.

Symbologies

Barcode symbologies define the mapping between a barcode and the text that it 
represents. There are more than 50 barcode symbologies. Barcode symbologies that 
are typically used in labs are those that create compact barcodes, such as Code 128, 
Code 39, and Interleaved 2 of 5. The Microplate Labeler also supports printing of 2D 
barcode symbologies. For examples of the symbologies that are supported by the 
Microplate Labeler printer, see “Supported barcode symbologies” on page 99.

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Designing label formats “Creating and editing label formats” on 
page 84

HelloSymbology
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Encoding and decoding

The printer includes encoding software that converts the text that you provide in a field 
into a barcode pattern.
If your Microplate Labeler has a barcode reader, the decoder software in the reader 
converts the pattern of a barcode back into text.

Encoding examples

The following example shows how a label will print when the word Test is represented 
in two types of fields:
• Field 1 as human-readable text 
• Field 2 as a barcode that uses the Code 128 symbology 

The next example uses the same symbology, but the words Test label are used for 
both fields. Notice that the barcode is longer because the amount of text encoded is 
greater.

In the following example, the words Test label are printed as a text field and as a 
barcode field using the Code 39 symbology. If you compare this with the previous 
example, you can see that the different symbology makes a different barcode pattern.

The two-dimensional (2D) barcodes can contain more information than conventional 
linear barcodes because they encode data in both horizontal and vertical directions. 

Decode

Encode

HelloSymbology

2

1
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Supported barcode symbologies

The following table provides a summary of the symbologies supported on the 
Microplate Labeler. You can find complete descriptions of the symbologies on the web 
at various sites, for example, www.wikipedia.org.

Symbology name Summary description

Code 128 Variable-length, high-density, symbology that can 
encode all 128 ASCII characters. Has 106 different bar 
and space patterns and each pattern can have one of 
three different meanings, depending on which of three 
different character sets is employed.

Codabar Variable-length, can encode the characters: 
0123456789-$:/.+ABCD

Code 39 Full ASCII Variable-length symbology that can encode the 
complete 128 ASCII character set. 

Code 93 Variable-length symbology that can encode the 
complete 128 ASCII character set. 

HIBC Variable-length, modified version of Code 39.
Health industry barcode (HIBC)

Interleaved 2 of 5 High-density variable-length, numeric-only (0–9) 
symbology that encodes numbers in pairs in an 
interleaved manner. 

PDF417 High-density 2D symbology that essentially consists of 
a stacked set of smaller barcodes.

MicroPDF417 A 2D multi-row symbology based on PDF417, designed 
for applications requiring a greater area efficiency but 
lower data capacity than PDF417.

Data Matrix High-density 2D matrix-style symbology that can 
encode up to 3116 characters from the entire 256-byte 
ASCII character set.
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Related topics

For information about... See...

Customizing a label format template “Creating and editing label formats” on 
page 84

Label format and content “About label formats and content” on 
page 80

Setting up a VWorks labeling protocol VWorks Automation Control User Guide, 
Print and Apply Task topic
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6+ Maintenance and troubleshooting
This chapter provides maintenance and troubleshooting information for the 
Microplate Labeler. 
The topics are:
• “Routine maintenance” on page 102
• “Checking the basic applicator functions” on page 104
• “Performing a print-and-apply test” on page 106
• “Using plate stage controls in Diagnostics” on page 109
• “Testing the barcode reader using Diagnostics” on page 112
• “Cleaning the device exterior” on page 113
• “Cleaning the printer components” on page 115
• “Resetting the label counter in the Diagnostics software” on page 117
• “Adjusting the feed path of the ribbon” on page 119
• “Cleaning and replacing the vacuum pads” on page 120
• “Disconnecting the air tubing” on page 123
• “Replacing the fuse” on page 124
• “Troubleshooting hardware problems” on page 126
• “Resolving error messages” on page 130
• “Using the cab SQUIX printer touchscreen” on page 133
• “Using the cab A2+ printer display and navigator pad” on page 135
• “Reporting problems” on page 137
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Routine maintenance

About this topic

Preventive maintenance is an important part of keeping the Microplate Labeler running 
smoothly and error free. This topic describes the periodic routine maintenance you 
should perform.
Contact Agilent Automation Solutions Technical Support if you are unable to resolve 
problems. 

Routine inspection and maintenance 

Your maintenance schedule can vary depending on the frequency of Microplate 
Labeler use. In general, you should perform routine maintenance tasks when you 
replace the printer ribbon and labels.

Maintenance task Schedule See…

Check the air-pressure level at 
the Microplate Labeler. 
Symptom. Insufficient air 
pressure or problems picking and 
placing the labels.

Daily “Checking the basic applicator 
functions” on page 104

Clean the Microplate Labeler.
Symptom. Dust, grime, or 
chemical deposits on exterior.

When 
replacing 
printer 
media

“Cleaning the device exterior” on 
page 113

Clean the print roller.
Symptom. Impairment of label 
advancement or degradation of 
print quality.

When 
replacing 
printer 
media

“Cleaning the printer 
components” on page 115

Clean the printhead.
Symptom. Degradation of print 
quality, contrast, or vertical 
stripes.

When 
replacing 
printer 
media

“Cleaning the printer 
components” on page 115

Clean the applicator head. 
Symptom. Dust and grime on 
applicator head.

When 
replacing 
printer 
media

“Cleaning the device exterior” on 
page 113

Clean and inspect the vacuum 
pads.
Symptom. Problems picking up 
labels from the printer or placing 
labels on labware.

Every three 
months

“Cleaning and replacing the 
vacuum pads” on page 120

Replace the vacuum pads.
Symptom. Cracked or worn pads.

Annually “Cleaning and replacing the 
vacuum pads” on page 120
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Related topics

Replace the labels and thermal 
transfer ribbon.
Symptom. End of media rolls.

As required “Loading labels and ribbon” on 
page 44

Maintenance task Schedule See…

For information about... See...

Hardware overview “Hardware overview” on page 12

Safety “Safety guidelines” on page 1

Troubleshooting hardware problems “Troubleshooting hardware problems” on 
page 126

Resolving error messages “Resolving error messages” on page 130

Reporting problems “Reporting problems” on page 137
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Checking the basic applicator functions

About this topic 

This topic describes how to use Microplate Labeler Diagnostics to verify the 
performance of basic applicator functions. You can perform this procedure at any time 
to double-check the applicator functions or to help troubleshoot problems.

Before you start

The following procedure assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 62.
• The profile for your device is initialized. For details, see “Initializing the device in 

diagnostics” on page 66.

Procedure

You can use the I/O Functions tab in Microplate Labeler Diagnostics to test basic 
applicator functions.
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To test basic applicator functions:
1 In the Microplate Labeler Diagnostics window, click the I/O Functions tab.
2 Under Output Functions, click a toggle button to perform the corresponding task 

and verify that the corresponding indicator lights in the Sensors area. 
Click the toggle button again to return to the original position. 

CAUTION
Before rotating the head, make sure that it is retracted and that a short side of plate 
stage is facing you as you stand in front of the device. Otherwise, the applicator 
head will hit the plate stage.

3 While observing the Green button press indicator in the Sensors area, press and 
hold the green button on top of the device. The Green button press light should 
turn on.
Note: If a print job has been created, pressing the green button will start the 
labeling operation.

4 Under Pressure (psi), verify that the air pressure readout is correct: 80 psi 
(0.55 MPa), minimum. 
• If the readout is <80 psi. Verify that the air source is supplying 80 psi 

(0.55 MPa), minimum. If the source is above 80 psi and the readout is below 
80 psi, use the pressure regulator knob on the back of the applicator to 
increase the pressure.

• If the readout is >87 psi. Use the pressure regulator knob on the back of the 
applicator to lower the pressure to 85 psi (0.58 MPa), maximum.

                                                        

Button Description
Extend head/Retract 
head

Extends or retracts the applicator head.
In the Sensors area, the Head retracted light turns on 
when the applicator head is retracted.

Rotate to stage/
Rotate to printer

The applicator head rotates to the plate stage or the 
printer. In the Sensors area, the Head rotated to printer 
or the Head rotated to stage light turns on to indicate 
the current position of the applicator head. 

Vacuum on/Vacuum 
off

Turns on or off the vacuum for the vacuum pads on the 
applicator head. 
If the vacuum is turned off when a label is attached to 
the vacuum pads, the label can drop.
If the vacuum pads are pressed against a surface, such 
as a label, while the vacuum is on, the Vacuum 
detected light turns on.

Drop stage/Raise 
stage

Raises or lowers the plate stage.

Blowoff on/Blowoff 
off

Starts or stops a stream of air through the vacuum 
pads on the applicator head.
If the air flow is on when a label is attached to the 
vacuum pads, the label is pushed off.
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Related topics

Performing a print-and-apply test

About this topic

This topic describes how to perform a print and apply test using the Testing tab in 
Microplate Labeler Diagnostics.

When to do a test print

Perform a print-and-apply test when first setting up your Microplate Labeler, after 
creating a new label format, when loading new labels and ribbon, or when 
troubleshooting printing problems.
Testing helps you detect problems such as:
• Incorrect height settings for the plate stage
• Incorrectly loaded label or ribbon 
• Poorly designed label formats, for example, overlapping fields, barcodes that are 

too large for the label, missing barcodes, or text fields that are too small to read

Before you begin

The following procedure assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 62.
• The profile for your device is initialized. For details, see “Initializing the device in 

diagnostics” on page 66.

For information about... See...

Resetting the air pressure “Setting the air pressure” on page 38

Rotating the plate stage “Using plate stage controls in Diagnostics” 
on page 109

Plate stage and applicator head “About plate stage and applicator head 
positions” on page 69

Raising or lowering the plate stage “Setting the plate stage vertical positions” 
on page 72

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics software” 
on page 139

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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IMPORTANT
Field data entered in the Testing tab of Microplate Labeler Diagnostics is stored 
temporarily in the computer and not the printer, so it can be used for testing purposes 
only. 

Procedure

To print a label from the Testing tab:

1 In the Testing tab, verify that the label format you want to use for this test is 
selected in the Format list. 
Note: You can display a preview of the label format in the Label Editor tab.

2 Under Label Data, type the text in the field box for the position that you want to test.
Note: Only the fields that are defined in the label format can be edited. Fields 
that are defined in the label format as barcode fields will be encoded into a 
barcode before printing.

3 In the Testing Options area, select Print and apply.
4 Select the compass points corresponding to one or more sides that you want to 

apply labels to, for example North and West.
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IMPORTANT
Make sure that the height of the plate stage is suitable for the type of microplate being 
labeled, and that there is a microplate on the plate stage.

5 In the Number of cycles list, set the value to the number of microplates that you 
want to test label.

6 Click Run test or press the green button on the top of the device.
The first label is printed and applied to the microplate.

7 If you are test labeling multiple microplates, quickly replace the microplate on the 
plate stage with a new one. 
Repeat this step until all the test cycles are completed.

Related topics

00143
VCode
placing plate

EastWest

South

North

A1 well

A1

A
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N
O
P

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

00143

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Placing a microplate “Placing a microplate on the plate stage” on 
page 68

Adjusting the height of the plate stage “Setting the plate stage vertical positions” 
on page 72

The overall process of designing a 
label format

“Creating and editing label formats” on 
page 84

Running a labeling protocol VWorks Automation Control User Guide

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics software” 
on page 139

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126
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Using plate stage controls in Diagnostics

About this topic

The plate stage controls in Microplate Labeler Diagnostics are useful when setting up 
the Microplate Labeler, troubleshooting, or performing maintenance on the Microplate 
Labeler. 
This topic describes how to use the Stage Setup tab to perform the following 
procedures:
• “Enabling and disabling plate stage auto-repositioning” on page 110
• “Rotating the plate stage using stage controls” on page 110
• “Moving the plate stage to a teachpoint” on page 111

Figure Stage Setup tab in Microplate Labeler Diagnostics

Before you begin

CAUTION
Before moving the plate stage, make sure that the applicator head is not in the 
rotation path of the plate stage.

The following procedure assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 62.
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• The profile for your device is initialized. For details, see “Initializing the device in 
diagnostics” on page 66.

Enabling and disabling plate stage auto-repositioning

By default, plate stage auto-repositioning is enabled. If the plate stage is moved from a 
position by an outside force (for example, if someone rotates the stage by hand), the 
auto-repositioning feature automatically moves the plate stage back to the last angle.
When setting up the device, troubleshooting, or performing maintenance on the 
Microplate Labeler, you can disable the auto-repositioning feature.

To disable plate stage auto-repositioning:
1 In the Stage Setup tab under Stage Controls, select the Disable stage auto-

repositioning check box.
When auto-repositioning is disabled, any disturbances that cause the plate stage 
to rotate will not be corrected until another move is commanded.

To enable plate stage auto-repositioning:
1 In the Stage Setup tab under Stage Controls, clear the Disable stage auto-

repositioning check box.

Rotating the plate stage using stage controls

To rotate the plate stage:
1 Ensure that the applicator head is pointing towards the printer. 

If the applicator head is pointing towards the plate stage:
a In Microplate Labeler Diagnostics, click the I/O Functions tab.
b Click Rotate to printer.
The applicator head rotates towards the printer, moving it out of the plate stage 
rotation path.

2 Move the plate stage in one of the following ways:

• To move relative to the current position. Under Stage Controls, type a value in 
the Angle increment box, and then click Rotate CCW (counterclockwise) or 
Rotate CW (clockwise).

• To move to a specific angle. Type a value in the Angle value box, and then click 
Move to.

• To rehome the plate stage. Click Home stage.
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Moving the plate stage to a teachpoint

1 Ensure that the applicator head is pointing towards the printer. 
If the applicator head is pointing towards the plate stage:
a In Microplate Labeler Diagnostics, click the I/O Functions tab.
b Click Rotate to printer.
The applicator head rotates towards the printer, moving it out of the plate stage 
rotation path.

2 Click the Stage setup tab. 
3 Make sure that Disable stage auto-repositioning is not selected.
4 Click Move here on the same row as the teachpoint to which you want to move.

The plate stage moves to the position.

Related topics

For information about... See...

Plate stage and head positions “About plate stage and applicator head 
positions” on page 69

Changing the robot pickup angle “Setting the robot pickup angle teachpoint” 
on page 76

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics software” 
on page 139

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126
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Testing the barcode reader using Diagnostics

About this topic

If you have installed the optional barcode reader on the Microplate Labeler, you can 
use the following procedure to test the reader.

Before you begin

The following procedure assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 62.
• The profile for your device is initialized. For details, see “Initializing the device in 

diagnostics” on page 66.

Procedure

To test the barcode reader using Microplate Labeler Diagnostics:
1 In the I/O Functions tab, under Barcode Reader, click Trigger BCR.

Note: If the button is unavailable, either the barcode reader was not detected 
during initialization, the Microplate Labeler was not previously initialized, or a 
microplate with a barcode label was on the plate stage during initialization.

2 In the Last value box, check the displayed result.
If you receive an error, make sure that the barcode reader’s laser lines are aligned 
with the label. For assistance, contact the Agilent Automation Solutions Technical 
Support.
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3 Move the plate stage so that another side of the microplate is exposed to the 
reader, and repeat the test.

Read angle information

The read angle is the position of the plate stage when a label is being read. This angle 
was set at the factory and should not require adjustment. You can view the setting for 
Read angle (east) teachpoint in the Stage Setup tab. This teachpoint specifies the 
angle to which the plate stage rotates so that the east side faces the optional barcode 
reader. To move the plate stage so that each of the other sides face the barcode 
reader, the software uses angles 90- , 180- , and 270-degrees from the teachpoint.
If barcodes cannot be read on all four sides of the microplate the read angle is not 
optimal. Contact the Agilent Automation Solutions Technical Support for assistance.

Related topics

Cleaning the device exterior

About this topic

This topic provides guidelines for periodic routine cleaning of the Microplate Labeler 
applicator to remove dust, grime, or chemical deposits on the exterior. 

Before you begin

WARNING
To avoid risk of electric shock, turn off the Microplate Labeler and disconnect the 
power cord before performing any maintenance or cleaning.

CAUTION
Do not use harsh abrasives, corrosive cleaning agents, or metal brushes to clean any 
Microplate Labeler component or accessory. The printer can be damaged by 
aggressive cleansers. Do not use abrasive cleaners, ethanol, or other solvents for 
cleaning the external surfaces or modules of the printer.

Ensure that you have the following:
• Standard laboratory wipes
• Mild soap-and-water solution 

For information about... See...

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics software” 
on page 139

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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• Soft brush or vacuum cleaner

Procedure

To clean the Microplate Labeler:
1 If you have not already done so, shut down the Microplate Labeler and disconnect 

the power cord.
2 Clean the printer exterior as follows:

a Use standard laboratory wipes and a mild soap-and-water solution to clean 
the printer cover.

b Remove dust and paper fluff from the print area with a soft brush or vacuum 
cleaner.

3 To clean the painted white surfaces and the aluminum surfaces of the device, use 
standard laboratory wipes and a mild soap-and-water solution.

Related topics

For information about... See...

Shutting down the Microplate Labeler “Starting up and shutting down” on 
page 54.

Hardware overview “Hardware overview” on page 12

Troubleshooting hardware problems “Troubleshooting hardware problems” on 
page 126

Cleaning the printhead and print roller “Cleaning the printer components” on 
page 115

Cleaning the applicator head vacuum 
pads

“Cleaning and replacing the vacuum pads” 
on page 120

Reporting problems “Reporting problems” on page 137
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Cleaning the printer components

About this topic

This topic describes how to clean the following Microplate Labeler printer 
components:
• Print roller. Accumulations of dirt on the print roller can impair the forward 

movement of the labels and ribbon and the impair the print quality.
• Printhead. Substances can accumulate on the printhead leading to degradation of 

print quality. 
Note: If the Microplate Labeler is fitted with a cab SQUIX printer, go to the printer 
touchscreen Help menu to view a video of how to clean the printhead.

When to do this

Clean the printhead and print roller when you replace the rolls of ribbon and labels. 
Cleaning the printhead regularly helps to ensure a consistently good printed image and 
prevents premature wear of the printhead. 
If the printer components appear damaged, contact Agilent Automation Solutions 
Technical Support.

Before you begin

Remove the labels and ribbon before you attempt to clean the printer components. For 
details, see “Loading labels and ribbon” on page 44.

WARNING
To avoid risk of electric shock, turn off the Microplate Labeler and disconnect the 
power cord before performing any maintenance or cleaning.

WARNING
The printhead is hot after use. To avoid risk of injury, ensure the printhead has 
cooled down before cleaning.

CAUTION
To avoid damage to the printhead, do not use sharp or hard objects to clean 
printhead. Do not touch the protective glass layer of printhead with your fingers.

Ensure that you have the following:
• Isopropyl alcohol and soft cloth to clean the print roller
• Cleaning pen from the Media Kit to clean the printhead

Alternatively, you can use a cotton swab dipped in isopropyl alcohol.

Procedure

The following figure shows the locations of the printer components referenced in this 
procedure.
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Figure Printhead and print roller locations

To clean the printer components:
1 Ensure the printhead lever (1) is turned counterclockwise lifting the printhead (2). 
2 Use the special cleaning pen to clean the printhead surface (2). The printhead is 

the narrow bar that presses the image through the ribbon and onto the label as the 
media move into position on the print roller.
Alternatively, if you do not have the cleaning pen, use a cotton swab dipped in 
isopropyl alcohol.

3 Use isopropyl alcohol and a soft cloth to remove any deposits from the print roller 
(3).

IMPORTANT
Allow the printhead to dry for 2–3 minutes before using the printer.

Related topics

1
2

3

For information about... See...

Shutting down the Microplate Labeler “Starting up and shutting down” on 
page 54.

Removing and installing the labels 
and ribbon in the printer

“Loading labels and ribbon” on page 44

Resetting the label counter “Resetting the label counter in the 
Diagnostics software” on page 117



117

6   Maintenance and troubleshooting
Resetting the label counter in the Diagnostics software

G5581A Microplate Labeler User Guide

Resetting the label counter in the Diagnostics software

About this topic

When you load a new roll of labels in the Microplate Labeler printer, you can reset the 
label counter Microplate Labeler Diagnostics to help you track the number of labels 
you use.

Before you begin

The following procedure assumes that:
• Microplate Labeler Diagnostics is open. For details, see “Opening Diagnostics” on 

page 62.
• The profile for your device is initialized. For details, see “Initializing the device in 

diagnostics” on page 66.

Procedure

To reset the label counter:
1 In Microplate Labeler Diagnostics, click the I/O Functions tab.

Cleaning the Microplate Labeler 
exterior

“Cleaning the device exterior” on page 113

Cleaning the applicator head vacuum 
pads

“Cleaning and replacing the vacuum pads” 
on page 120

Troubleshooting hardware problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137

For information about... See...
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2 Under Label Count Tracking, click Reset counter.
3 In the Select label roll type list, select the size of the roll.

If you selected the Custom roll size, proceed to step 4.
4 Type the number of labels in the Labels per roll box, and then click Set custom roll 

size.

Related topics

For information about... See...

Loading new labels “Loading labels and ribbon” on page 44

Designing label formats “Creating and editing label formats” on 
page 84

Microplate Labeler Diagnostics 
controls and indicators

“Quick reference to Diagnostics software” 
on page 139

Performing a print-and-apply test “Performing a print-and-apply test” on 
page 106

Troubleshooting problems “Troubleshooting hardware problems” on 
page 126
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Adjusting the feed path of the ribbon

About this topic

Rarely, ribbon wrinkling can lead to print image errors. This topic describes how to 
make minor adjustments to the feed path of the ribbon.

Procedure

IMPORTANT
This adjustment should be performed during printing.

Figure Setting the feed path of the ribbon

To set the feed path of the transfer ribbon:
1 Read the current setting on the scale (1) and record, if necessary.
2 Turn the screw (2) using a hex wrench and observe the behavior of the ribbon.

To tighten the inner edge of the ribbon turn in the + direction. To tighten the outer 
edge of the ribbon, turn in the - direction. 

                                                        

1

2
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Related topics

Cleaning and replacing the vacuum pads

About this topic

The applicator head on the Microplate Labeler uses vacuum pads to pick up the 
printed labels from the printer and place the printed labels on the labware. This topic 
describes how to clean and, if necessary, replace the vacuum pads. 

When to do this procedure

To maintain proper function, the vacuum pads must be clean and undamaged. A 
sticky residue from the label adhesive can build up on the vacuum pads. You 
should routinely clean the vacuum pads when you change the printer ribbon and 
labels. 
If the Microplate Labeler is not picking up or placing the labels correctly and the air 
pressure setting is correct, try cleaning the vacuum pads. 
If the vacuum pads are cracked, replace the vacuum pads.

Before you begin

CAUTION
Do not use harsh abrasives, corrosive cleaning agents, or metal brushes to clean any 
Microplate Labeler component or accessory.

Make sure you have the following items:
• Cotton swabs
• Mild soap and water solution
• Replacement vacuum pads, if required

For information about... See...

Printer components “Printer overview” on page 15

Removing and installing the labels 
and ribbon in the printer

“Loading labels and ribbon” on page 44

Cleaning the printer components “Cleaning the printer components” on 
page 115

Troubleshooting hardware problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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Cleaning the vacuum pads

Figure Cleaning the vacuum pads on the applicator head

To clean the vacuum pads on the Microplate Labeler applicator head:
1 Open Microplate Labeler Diagnostics, click the Profile tab, and initialize the profile 

for the device.
2 To ensure the plate stage is out of the path of the applicator head:

a In the Stage Setup tab, select the Disable stage auto-repositioning check box.
b Gently rotate the plate stage manually so that it is out of the path of the 

applicator head.
3 To ensure that the applicator head is retracted and rotated away from the printer 

for easier access: 
a In the I/O Functions tab, click Retract head. 
b Click Rotate to stage.

4 Use soapy water and a cotton swab to wipe the surface of the vacuum pads that 
contacts the labels. Remove any dust and grease from each pad.
Note: The pads can develop a sticky residue from the label adhesive, which 
may require more effort to remove.

5 Wait for the vacuum pads to dry.
6 Run a print-and-apply test to verify that the vacuum pads are functioning properly. 

For details, see “Performing a print-and-apply test” on page 106.
If the vacuum pads are functioning properly, ensure that the applicator head is 
clear of the path of the plate stage. In the Stage Setup tab, clear the Disable stage 
auto-repositioning check box.
If problems persist, replace the vacuum pads using the following procedure or 
contact Agilent Automation Solutions Technical Support.

Inspecting and replacing the vacuum pads

Before removing the vacuum pads, try cleaning them, and then run a print-and-apply 
test to see if the problem persists.

00386 clean vac pad
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Figure Replacing the vacuum pads on the applicator head

To inspect and replace the vacuum pads:
1 To gain access to the vacuum pads:

a Ensure that the plate stage is rotated out of the path of the applicator head.
b Rotate the applicator head towards the plate stage.

2 Grab the vacuum pad firmly with your fingers, and pull the pad off of the applicator 
head.

3 Roll the vacuum pad between your fingers and look for cracks or splits along the 
length of the pad.
If a vacuum pad seems worn or has cracks or splits, replace all six vacuum pads.

4 Install new vacuum pads by pressing them onto the applicator head with your 
fingers.

Related topics

00385 vac pad removal

For information about... See...

Shutting down the Microplate Labeler “Starting up and shutting down” on 
page 54.

Hardware overview “Hardware overview” on page 12

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Cleaning the Microplate Labeler 
exterior

“Cleaning the device exterior” on page 113

Cleaning the printhead and the print 
roller

“Cleaning the printer components” on 
page 115

Troubleshooting hardware problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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Disconnecting the air tubing

About this topic

This topic explains how to disconnect the air tubing without damaging the air input 
connector. 
Before moving or shipping the Microplate Labeler you must disconnect the air tubing. 
You may also want to do this before performing maintenance or cleaning the device. 

Before you begin

WARNING
To avoid injury, turn off the air supply before disconnecting the air tubing. When air 
is flowing, air tubing can injure you if it whips around and strikes you. If you have not 
been trained in the correct way to handle air tubing, contact your facilities 
department.

CAUTION
Follow the directions in this topic to correctly disconnect the air tubing from the 
Microplate Labeler air supply port in order to avoid damage to the device.

 Procedure

To disconnect the air tubing:
1 Turn off the air source so that there is no air pressure to the Microplate Labeler.
2 Push in the orange locking collar on the quick-release fitting.

3 With your free hand, gently pull on the air tubing until it comes free.
 

00080
VSpin
attach air hose

00080

Orange locking 
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Related topics

Replacing the fuse

About this topic

This topic describes how to replace the main fuse in the Microplate Labeler.

Before you begin

Use only the specified fuse type:
3 A, 0.25 x 1.25 in (6.35  x 31.75 mm), fast acting
You can order replacement fuses from Agilent Technologies.

CAUTION
A blown fuse can indicate more serious problems. If the new fuse blows after 
replacement, contact Agilent Automation Solutions Technical Support.

Using an incorrect fuse can damage the Microplate Labeler.

Procedure

To replace the fuse in the power switch:
1 Shut down the Microplate Labeler, and unplug the power cable from the rear panel 

connector.
2 At the rear panel power switch enclosure, use a small flat-head screwdriver (2.5 

mm) to pry open the tab on the enclosure and open the enclosure cover.

For information about... See...

Connecting air supply • “Connecting the air tubing: non-metric” 
on page 34

• “Connecting the air tubing: metric” on 
page 36

Troubleshooting hardware problems “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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Figure Fuse enclosure location

3  Slide the fuse cartridge all the way out of the enclosure.

Figure Opened fuse enclosure

4 Replace the fuse in the cartridge.
5 Slide the fuse cartridge back into the power switch enclosure.
6 Press the enclosure cover securely into the closed position.
7 Plug in the power cable at the rear panel connector, and then start up the 

Microplate Labeler.
 

Related topics

For information about... See...

Connecting the power cable “Connecting the power cord” on page 39

Shutting down the Microplate Labeler “Starting up and shutting down” on page 54



6   Maintenance and troubleshooting
Troubleshooting hardware problems

126 G5581A Microplate Labeler User Guide

Troubleshooting hardware problems

About this topic

This topic describes some commonly-encountered hardware problems and provides 
suggestions for how to solve them.
If you encounter a problem, review the following tables first to see if you can solve the 
problem:
• “Communications or power problems” on page 126
• “Air pressure and label pick-and-place problems” on page 128
• “Printing problems” on page 128
If an error message appears, see “Resolving error messages” on page 130.
If your problem is not listed, or you are not able to resolve the problem, contact Agilent 
Automation Solutions Technical Support. See “Reporting problems” on page 137.

Communications or power problems

Problem Possible cause Possible solution

The Microplate 
Labeler does not turn 
on.

The power cord is not 
connected or is 
defective.

Ensure that the power cord is connected to the Microplate 
Labeler connection panel at the rear of the applicator. See 
“Connecting the power cord” on page 39.
Make sure the power cord is in good condition.

The fuse is bad. See “Replacing the fuse” on page 124.

IMPORTANT A blown fuse can indicate other 
problems. If the fuse blows again, contact Agilent 
Automation Solutions Technical Support.

The profile failed to 
initialize the device.

The communications 
cable is not properly 
connected, or the 
wrong cable is being 
used.

Verify that the correct cable is properly connected. 
Note: Ethernet is the recommended mode of 
communication.
See “Connecting the device to the computer” on page 41.

The printer is not in a 
Ready state.

The Ready message must appear on the printer’s display 
before the Microplate Labeler can initialize. If the Ready 
message does not appear:

1 Open the printer cover, and verify that the printhead 
lever is down.

2 Turn off the power to the Microplate Labeler, wait a 
full 5 seconds, and then turn on the power.
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Communication is not 
established with an 
Ethernet connection.

The communications 
cable is not properly 
connected, or the 
wrong cable is being 
used.

Verify the computer was connected correctly to the 
Ethernet port on the Microplate Labeler connection panel 
(at the back of the applicator). See “Connecting the device 
to the computer” on page 41.

The IP address setting 
is incorrect.

If you are connecting multiple Microplate Labeler devices 
on the same network, contact Agilent Automation 
Solutions Technical Support for guidance on setting the IP 
addresses.
For details on how to connect to the device via Ethernet, 
see “Connecting the device to the computer” on page 41.

Communication is not 
established with a 
serial connection.

The communications 
cable is not properly 
connected, or the 
wrong cable is being 
used.

Verify that the computer was connected correctly to the 
serial port on the Microplate Labeler connection panel (at 
the back of the applicator). See “Connecting the device to 
the computer” on page 41.

Wrong COM port 
selected

Verify that the selected profile specifies the correct COM 
port on the computer.

To verify the COM port in the profile:
1 In Microplate Labeler Diagnostics, click the Profiles 

tab.
2 Select the profile, and verify the selected COM port is 

correct for your connection.
For details on creating or editing profiles, see “Creating a 
profile” on page 64.

The printer screen is 
blank.

The printer was not 
initialized properly or 
the power was cycled 
too quickly.

At the Microplate Labeler connection panel (on the back 
of the applicator), press the power switch to the off (o) 
position, wait a full 5 seconds, and then press the power 
switch to the on (|) position.

The printer power 
switch is in the off (o) 
position.

Ensure that the power switch on the back of the printer 
remains in the on (|) position at all times.

In Microplate Labeler 
Diagnostics, the 
Trigger BCR button 
and Verify barcodes 
buttons are 
unavailable. 

The barcode reader 
was not detected during 
initialization, or the 
Microplate Labeler was 
not initialized.

Make sure the barcode reader is installed properly.
For details, contact Agilent Automation Solutions 
Technical Support.

Problem Possible cause Possible solution
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Air pressure and label pick-and-place problems

Printing problems 

Problem Possible cause Possible solution

The applicator head 
does not retract, 
extend, or rotate on 
command and you 
can hear a hissing 
sound.

An air leak is present. Inspect the air tubing and check the air connection on the 
Microplate Labeler connection panel and at the source for 
leaks.
For connection details, see “Connecting the air tubing: 
non-metric” on page 34 or “Connecting the air tubing: 
metric” on page 36.

The applicator head 
does not extend far 
enough to reach the 
labels at the printer, or 
is retracting too soon.

The air pressure is set 
incorrectly.

Check the air pressure and adjust the pressure as 
necessary.
See “Checking the basic applicator functions” on 
page 104.

The pneumatics flow 
control requires 
adjustment.

Contact Agilent Automation Solutions Technical Support.

Labels are not being 
picked up from the 
printer.

The air pressure is set 
incorrectly.

Check the air pressure and adjust the pressure as 
necessary.
See “Checking the basic applicator functions” on 
page 104.

The vacuum pads are 
dirty or worn.

See “Cleaning and replacing the vacuum pads” on 
page 120.

The applicator head 
height or internal 
pressure settings 
require adjustment.

Contact Agilent Automation Solutions Technical Support.

A label is “flipped 
over” when the 
applicator head is 
picking it up from the 
printer.

The vacuum pads are 
dirty or worn.

Remove the label and clean the vacuum pads. 
See “Cleaning and replacing the vacuum pads” on 
page 120.
If the problem persists, contact Agilent Automation 
Solutions Technical Support.

Problem Possible cause Possible solution

The printed image is 
not clear.

The wrong type of 
media is installed, or the 
media is installed 
incorrectly.

Make sure that you are using the ribbon and labels 
provided in the Microplate Labeler Media Kit. 
See “Loading labels and ribbon” on page 44.

The transfer ribbon is 
wrinkled.

See “Adjusting the feed path of the ribbon” on page 119.
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Related topics

The print image has 
smears or blanks, or 
one side is lighter 
than the other.

The printhead is dirty. See “Cleaning the printer components” on page 115.

The labels feed 
through the printer, 
but the ribbon does 
not move.

The ribbon is installed 
incorrectly.

Make sure that you are using the ribbon and labels 
provided in the Microplate Labeler Media Kit, and that the 
media is installed correctly. 
See “Loading labels and ribbon” on page 44.

The labels are drifting 
at the peelbar.

Excess media backing 
up on the take-up reel.

Discard the excess labels and ribbon and re-install labels 
and ribbon.
See “Loading labels and ribbon” on page 44.

Problem Possible cause Possible solution

For information about... See...

Shutting down the Microplate Labeler “Starting up and shutting down” on 
page 54.

Hardware overview “Hardware overview” on page 12

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Preventive maintenance schedule “Routine maintenance” on page 102

Resolving error messages “Resolving error messages” on page 130

Reporting problems “Reporting problems” on page 137



6   Maintenance and troubleshooting
Resolving error messages

130 G5581A Microplate Labeler User Guide

Resolving error messages

About this topic

This topic describes commonly-encountered error messages for the Microplate 
Labeler and how to resolve them. 
If you encounter a problem, review the following tables first to see if you can solve the 
problem:
• “Air pressure messages” on page 130
• “Applicator head error messages” on page 130
• “Communication messages” on page 131
• “Printer error messages” on page 131
If you have a hardware problem, see “Troubleshooting hardware problems” on 
page 126.
If your problem is not listed, or you are not able to resolve the problem, contact Agilent 
Automation Solutions Technical Support. See “Reporting problems” on page 137.

Air pressure messages

Applicator head error messages

Error message Possible cause Solution

Air pressure is out of range. The air pressure is too high or too 
low.

In Microplate Labeler Diagnostics, check 
the air pressure reading on the I/O 
Functions tab.
See “Checking the basic applicator 
functions” on page 104.

An unknown error occurred 
when reading the air pressure 
before stage motion.

The air pressure is too high or too 
low.

In Microplate Labeler Diagnostics, check 
the air pressure reading on the I/O 
Functions tab.
See “Checking the basic applicator 
functions” on page 104.

Error message Possible cause Solution

An error occurred when 
picking the label.

Dirty vacuum pads or worn 
vacuum pads.

Clean and inspect the vacuum pads. 
Replace worn vacuum pads.
See “Cleaning and replacing the vacuum 
pads” on page 120.

The wrong type of media is 
installed, or the media is installed 
incorrectly.

Make sure that you are using the ribbon 
and labels provided in the Microplate 
Labeler Media Kit. 
See “Loading labels and ribbon” on 
page 44 for installation instructions.
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Communication messages

Printer error messages

An error occurred when 
extending the head.

The air pressure is too high or too 
low.

In Microplate Labeler Diagnostics, check 
the air pressure reading on the I/O 
Functions tab.
See “Checking the basic applicator 
functions” on page 104.

An error occurred when 
applying the label.

The plate stage does not contain 
a microplate.

Ensure that a microplate is on the plate 
stage and try again.

Error message Possible cause Solution

Error message Possible cause Solution

A serial error occurred. The communications cable is not 
connected properly, or the wrong 
cable is being used.

Verify that the computer was connected 
correctly to the serial port on the 
Microplate Labeler connection panel (at 
the back of the applicator).
See “Connecting the device to the 
computer” on page 41.

The wrong COM port on the 
computer is specified in the 
profile. 

Verify that the selected profile specifies 
the correct COM port on the computer.

To verify the COM port in the profile:
1 In Microplate Labeler Diagnostics, 

click the Profiles tab.
2 Select the profile, and verify the 

selected COM port is correct for 
your connection.

See “Creating a profile” on page 64.

An unknown error has 
occurred.

An unknown error has occurred. At the Microplate Labeler connection 
panel (on the back of the applicator), 
press the power switch to the off (o) 
position, wait a full 5 seconds, and then 
press the power switch to the on (|) 
position.

Error message Possible cause Solution

An error occurred when 
adjusting the printer format.

The label format contains errors. Open Microplate Labeler Diagnostics 
and check label format.
See “Creating and editing label formats” 
on page 84.
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Related topics

An error occurred when form 
feeding the printer.

The wrong type of media is 
installed, or the media is installed 
incorrectly.

Make sure that you are using the ribbon 
and labels provided in the Microplate 
Labeler Media Kit. 
See “Loading labels and ribbon” on 
page 44 for installation instructions.

Either the printer command 
was malformed or the 
barcode size settings are too 
large.

The label format contains errors. See “Creating and editing label formats” 
on page 84.

Empty input, please try again. The label format name is missing. Enter the label format name.

The printer is not ready. The printer was not initialized 
properly or the power was cycled 
too quickly.

At the Microplate Labeler connection 
panel (on the back of the applicator), 
press the power switch to the off (o) 
position, wait a full 5 seconds, and then 
press the power switch to the on (|) 
position.

The display on the front of the 
printer indicates a state other 
than Ready.

Return the printer to the Ready state.
For the cab SQUIX printer, see “Using the 
cab SQUIX printer touchscreen” on 
page 133.
For the cab A2+ printer, see “Using the 
cab A2+ printer display and navigator 
pad” on page 135.

The printer power switch is in the 
off (o) position.

Ensure that the power switch on the 
back of the printer remains in the on (|) 
position at all times.

Error message Possible cause Solution

For information about... See...

Routine maintenance “Routine maintenance” on page 102

Troubleshooting the hardware “Troubleshooting hardware problems” on 
page 126

Reporting problems “Reporting problems” on page 137
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Using the cab SQUIX printer touchscreen

About this topic

Agilent Automation Solutions Technical Support might request the printer status 
information from you when troubleshooting the Microplate Labeler. This topic 
describes how to view information for the cab SQUIX printer.

CAUTION
Do not use the touchscreen to adjust the printer settings unless directed to do so by 
Agilent Automation Solutions Technical Support.The printer has been specially 
configured as part of the Microplate Labeler. Using the touchscreen menus to 
change the printer settings can cause the Microplate Labeler to fail. 

IMPORTANT
The printer display must show the Ready message before you can initialize the device. 
During operation, the software displays operator messages and error messages on the 
computer screen. 

Touchscreen start page

Figure Touchscreen start page

                                                        

Icon See...

Opens the menu.

Interrupts the print job or continues the print job.
Appears only when a print job is in progress.

Repeats the last printed label.
Available after a print job.

Cancels all print jobs and returns the printer to the Ready state.

Feeds a blank label.
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Viewing the printer menu

To view the printer menu:
1 On the printer touchscreen start page, ensure that the Ready message is 

displayed. 

If a message other than Ready appears, click  to stop any printing processes.

2 Click  to display the Menu page.

Figure Touchscreen Menu page

On the Menu page, you may view the following items:

 Info. Displays information about the printer, including firmware version, 
Ethernet connection, hours or operation and number of labels, and so forth.

 Help. Displays videos on how to clean the printhead, load labels, and load 
ribbon.
All other menu items are for Agilent use only.

CAUTION
Do not use the touchscreen to adjust the printer settings unless directed to do so by 
Agilent Automation Solutions Technical Support. Using the touchscreen menus to 
change the printer settings can cause the Microplate Labeler to fail. The printer has 
been specially configured as part of the Microplate Labeler. 
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Using the cab A2+ printer display and navigator pad

About this topic

Agilent Automation Solutions Technical Support might request the device status 
information from you when troubleshooting the Microplate Labeler. This topic 
describes how to view the status information for the cab A2+ printer and how to return 
the printer to the Ready state.

CAUTION
Do not use the navigator pad to adjust the printer settings unless directed to do so 
by Agilent Automation Solutions Technical Support. Using the printer navigator pad 
to change the printer settings can cause the Microplate Labeler to fail. The printer 
has been specially configured as part of the Microplate Labeler. 

About the navigator pad and service display

You may use the printer service display (figure, item 1) and the navigator pad (figure, 
item 2) to access the status menu. 

Figure Printer service display and navigator pad

                                                        

1

2 pause

cancel

menu feed
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The navigator pad has the following keys. The key functions depend on the current 
printer state.

Viewing the status menu

To view the status menu:

1 On the navigator pad (figure, item 2), press the  menu key.

2 Press the  feed key to move to the Short status icon in the display, and then 

press the  key to select the Short status menu.

3 Click the  and  (pause and cancel) keys to scroll through the individual 
lines.

Returning the printer display to the Ready state

To return the printer display to the Ready state:

1 To exit the status menu press the  key.

2 Scroll to the left by pressing the  menu key repeatedly until Ready appears on the 
printer display (figure, item 1). 

IMPORTANT
The printer display must show the Ready message before you can initialize the device. 
During operation, the software displays operator messages and error messages on the 
computer screen. 

Related topics

Key Label

menu

feed

pause

cancel

–

For information about... See...

Routine maintenance “Routine maintenance” on page 102

Troubleshooting the hardware “Troubleshooting hardware problems” on 
page 126
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Reporting problems

Contacting technical support

If you find a problem with the Microplate Labeler, contact Agilent  Automation 
Solutions Technical Support. For contact information, go to https://www.agilent.com/
en-us/contact-us/page.
Note: You can also send a software bug report from within the VWorks software.

Reporting hardware problems

When contacting Agilent , make sure you have the serial number of the device or 
workstation ready.

Reporting software problems

When you contact Agilent Automation Solutions Technical Support, make sure you 
provide the following:
• Short description of the problem

• Software version number
• Error message text (or screen capture of the error message dialog box)
• Screen capture of the About VWorks software dialog box
• Relevant software files

To find the VWorks software version number:
In the VWorks software, select Help > About VWorks.

To find the Diagnostics software version number:
1 Open Diagnostics.
2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:
In the VWorks software, select File > Export to export and compress the following files:
• Protocol file
• Device file (includes the device profile and teachpoint file)
• Labware definitions
• Liquid classes
• Pipette techniques
• Hit-picking files
• Plate map files

Reporting problems “Reporting problems” on page 137

For information about... See...

https://www.agilent.com/en-us/contact-us/page
https://www.agilent.com/en-us/contact-us/page
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• Barcode files
• Error library
• Log files
• Form file (*.VWForm)

Reporting user guide problems

If you find a problem with this user guide or have suggestions for improvement, send 
your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
 

Related topics

For information about... See...

Routine maintenance and 
troubleshooting

“Routine maintenance” on page 102

Hardware problems “Troubleshooting hardware problems” on 
page 126

Software problems “Resolving error messages” on page 130

mailto:documentation.automation@agilent.com
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A Quick reference to Diagnostics software
This section provides a quick reference to the Microplate Labeler Diagnostics 
software. The topics are:
• “Testing tab” on page 140
• “Label Editor tab” on page 144
• “I/O Functions tab” on page 150
• “Stage Setup tab” on page 156
• “Profiles tab” on page 160



A   Quick reference to Diagnostics software
Testing tab

140 G5581A Microplate Labeler User Guide

Testing tab

About this topic

This topic provides a quick reference to the controls and indicators in the Microplate 
Labeler Diagnostics—Testing tab. You can use the controls and indicators in the 
Testing tab to perform print or print-and-apply tests.

Figure Testing tab

Testing tab procedures

The Testing tab enables you to:

Testing tab contents

The Testing tab contains the following:
• Label Format Settings area
• Label Data area
• Testing Options area

Procedure See...

Print or print and apply one or more 
test labels

“Performing a print-and-apply test” on 
page 106
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• Cycle Options area

Label Format Settings area

Label Data area

Controls and indicators Description

Format Allows you to select a label format that is currently 
loaded in the printer to use for a print or print-and-apply 
test.

Controls and indicators Description

Field 1 to Field 6 Allows you to type text in the designated fields for the 
test label. Fields that are defined in the label format as 
barcode fields will be encoded into the specified barcode 
symbology before printing.
The field data entered into Microplate Labeler 
Diagnostics is temporarily stored in the computer and 
not the printer, so it can only be used for testing 
purposes. 
Note: Only the fields defined in the currently selected 
format are available.
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Testing Options area

                                                        

Controls and indicators Description

Print only Specifies a print operation, where one or more test labels 
are printed without applying them to microplates.

Print and apply Specifies a print-and-apply operation, where one or more 
test labels are printed and applied to microplates.

Verify barcodes Available for optional barcode reader only. Enables the 
barcode reader during a print-and-apply test. Use this 
feature to verify that the barcodes can be read by the 
barcode reader after the labels are printed and applied to 
a microplate.

Drop stage Moves the plate stage to the lower stage position.

Select sides Specifies the sides of the microplate to which to apply 
test labels.
When the microplate is on the plate stage, the sides of 
the microplate are referred to as north, south, east, and 
west as the figure shows.



143

A   Quick reference to Diagnostics software
Testing tab

G5581A Microplate Labeler User Guide

Cycle Options area

Related information

Controls and indicators Description

Number of cycles Specifies the number of test cycles to run using the 
specified label data and testing options.
For example, if you select format 1, and specify the Print 
and apply option, the North side, and 10 cycles, the 
device would print and apply labels onto the North side of 
10 microplates.

Run test Starts the test cycles.

Abort test Stops the test cycles.

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics software” 
on page 139

Label formats and fields “About label formats and content” on 
page 80
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Label Editor tab

About this topic

This topic provides a quick reference to the controls and indicators in the Microplate 
Labeler Diagnostics—Label Editor tab. You use the controls and indicators in the Label 
Editor tab to design label formats and save them.
The Microplate Labeler includes templates for the label formats that are ready to use 
or customize. For an overview of the templates, see “Templates for barcode formats” 
on page 165.

Figure Label Editor tab

Label Editor tab procedures

The Label Editor tab enables you to:

Procedure See...

Create or edit label formats “Creating and editing label formats” on 
page 84

Print a test label of a format that has 
been uploaded to the printer

“Printing a test label from the Label Editor 
tab” on page 92

Upload label formats to the printer “Uploading and saving a format” on 
page 91
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Label Editor contents

The Label Editor tab contains the following:
• Format selection list and format buttons
• Label Field Data table
• Label Editor preview box

Format selection list and format buttons

Save label formats to XML files “Uploading and saving a format” on 
page 91

Procedure See...

Controls and indicators Description

Current format Specifies the format that you are loading into memory for 
editing, or that you are saving to disk or uploading to the 
printer. 
Label format templates are included with the Microplate 
Labeler. You can load the formats from the printer or 
from the computer. 
Only label formats that have been uploaded to the printer 
can be printed or printed and applied.

Rename format Opens a dialog box where you can enter a new name for 
the label format.

Rename field Opens a dialog box where you can enter an alias for the 
selected field (Index 1 to Index 6).

Load from printer Temporarily loads a label format selected in the Current 
format list from the printer into the Label Editor tab for 
editing or saving to disk.

Save format to disk Opens the Save As dialog box where you can save the 
displayed label format to an XML file. Each label format is 
saved as a separate XML file.
By default, the label formats are in the following folder:
C:\VWorks Workspace\Microplate Labeler Label Formats
Label formats can be accidentally overwritten in the 
printer, so you should save backup copies of the label 
formats in XML files.
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Label Field Data table
The Label Field Data table displays the data for the label format that is currently loaded 
in the Label Editor tab. 

Each row in the table represents a field in the currently selected label format. The Label 
Field Data table columns include the following:

Load format from disk Displays the Open dialog box, where you can select a 
label format that was saved as an XML file, and load the 
label format into the Label Editor tab temporarily for 
editing or uploading to the printer.
By default, label format templates are installed in the 
following folder:
C:\VWorks Workspace\Microplate Labeler Label Formats
Note: Only the label formats created for the cab A2+ 
printer are supported on the Microplate Labeler.

Upload format to printer Uploads the displayed label format to the printer.
Only the label formats stored in the printer are available 
for labeling protocols (VWorks software), or print-and-
apply tests (Microplate Labeler Diagnostics).

Print test label Performs a test print of a format stored in the printer that 
you have selected in the Current format list. 
Only the label formats stored in the printer are available 
for printing.

Controls and indicators Description

Column Description

Index Indicates the number of the field. Each field defined in the 
label format is given an index number from 1 through 6.
Only field 2 can be a barcode field. All other fields can be 
human-readable text.
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Field Alias Specifies a name for the field. The default alias is the 
index number. 
To change the alias to something more descriptive, 
select the field row in the table, click the Rename field 
button, and then type the new name in the dialog box that 
appears.

Field Type Specifies whether the field is human-readable text or 
barcode.
• Field 1 must be human-readable text. 
• Field 2 can be a barcode or human-readable text. 
• Fields 3–6 can be human-readable text.

IMPORTANT To ensure that the barcode reader can 
read a barcode, the label should include a blank margin 
(quiet zone) on each end of the barcode field. In general, 
the quiet zone should be 10 times the dimension of the 
narrowest bar in the barcode or 0.25 inch (0.635 cm), 
whichever is greater.

Value Test purposes only. Specifies the contents of the field for 
a test print using the Print test label button in the Label 
Editor tab. 
Click the Value box for the given field, click the box again, 
and then type the new value:
• Text/numeric field. The value is the actual text that 

will be printed during a test print.
• Barcode field. The value is the actual data that is 

encoded into the barcode for a test print. The 
barcode text should follow the rules of the specified 
symbology, for example, limited to numbers only or 
uppercase letters and numbers.

These values are not used for production print jobs. 
When you run a labeling protocol or a print job, the value 
of each field comes from the data that you select in the 
VWorks software.
If you do print tests from the Testing tab, the values from 
the Label Editor tab are not used.

Format Specifies the printing format to be used when printing the 
field. Assigns the text font or barcode symbology, 
depending on whether the field is a text field or a barcode 
field.
Ensure that the characters you enter for a barcode field 
are supported by the selected format (symbology). For 
an overview of the supported barcode symbologies, see 
“Barcodes and supported symbologies” on page 97.

Column Description
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Label Editor preview box
The Label Editor preview box allows you to add and delete fields, drag fields to 
reposition them on the label, and view an approximation of how the printed label will 
appear. The preview is not precise, and you must test print the label to see the actual 
field positions, and then adjust as necessary. To specify the exact coordinates, you 
can type the values for the coordinates in the Label Field Data table X and Y columns.
If you load an undefined format, the Label Editor preview box is empty. To add new 
fields to format, right-click the preview box to display a shortcut menu.

X, Y Specifies the printer coordinates on the label for the 
position of each field, where
• Text field. The X,Y values specify the bottom, left 

corner of the field.
• Barcode field. The X,Y values specify the top, left 

corner of the field.
The Label Editor preview box displays the x, y 
coordinates as the intersection of a pair of thin blue lines, 
either at the top left of a barcode field, or the bottom left 
of a text field.

To change the field position, you can type new values in 
the X and Y columns. The coordinates are measured in 
0.001-in (0.0254-mm) increments. Given a label size of 
0.25 by 2.0 in (0.0635 by 5.08 cm), the range of possible 
values is as follows:
Y: 0 to 250
X: 0 to 2000
Note: Alternatively, you can drag the field to a new 
position in the Label Editor preview box. However, this is 
not as precise a method for positioning the field.
When the format is uploaded to the printer, the software 
transfers the x, y coordinates to the printer label 
coordinates.

Attributes Indicates the field size and other attributes. 
For details on changing the attributes, see “Changing the 
field size and other attributes” on page 92.

Column Description
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The shortcut menu contains the following commands:

Related information

Command Description

Insert barcode Available for field 2 only. Inserts a barcode field in the 
Label Editor preview box and adds a barcode field to the 
Label Field Data table. 
A pair of thin blue lines with arrows appear on the top and 
left sides of the barcode field in the preview box. The 
intersection of the blue lines represents the printer 
x, y coordinates for the field position on the label.
Only one barcode field is allowed per label format. 

Insert text Inserts a text (human readable) field in the Label Editor 
preview box and adds a text field to the Label Field Data 
table.
A pair of thin blue lines with arrows appear on the bottom 
and left sides of the text field in the preview box. The 
intersection of the blue lines represents the printer x, y 
coordinates for the field position on the label.

Delete field Deletes the field that is highlighted in the Label Field Data 
table.

Clear label Clears all fields from the Label Editor preview box and the 
Label Field Data area.

For information about... See...

Label templates “Templates for barcode formats” on 
page 165

Testing tab “Testing tab” on page 140
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I/O Functions tab

About this topic

This topic provides a quick reference to the controls and indicators in the Microplate 
Labeler Diagnostics—I/O Functions tab. The controls and indicators in the I/O 
Functions tab are used primarily for verifying the correct functioning of the applicator 
and for troubleshooting problems.

Figure I/O Functions tab

I/O Functions tab procedures

The I/O Functions tab enables you to:

Procedure See...

Extend or retract the applicator head “Checking the basic applicator functions” 
on page 104

Rotate the applicator head to the plate 
stage and back to the printer

“Checking the basic applicator functions” 
on page 104

Turn the vacuum on and off “Checking the basic applicator functions” 
on page 104

Move the plate stage from the top 
position to the bottom position and 
back 

“Checking the basic applicator functions” 
on page 104
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I/O Functions tab contents

The I/O Functions tab contains the following:
• Output Functions area
• Sensors area
• Label Count Tracking area
• Barcode Reader area

Output Functions area

Turn on and off the blowoff air “Checking the basic applicator functions” 
on page 104

Check the regulated air pressure “Checking the basic applicator functions” 
on page 104

Reset the labels printed counter to 
track the labels used per roll

“Resetting the label counter in the 
Diagnostics software” on page 117

Trigger the barcode reader “Testing the barcode reader using 
Diagnostics” on page 112

Procedure See...

Controls and indicators Description

Extend head/
Retract head

Extends or retracts the applicator head.

Rotate to stage/
Rotate to printer

Rotates the applicator head to the plate stage or to the 
printer.

Vacuum on/Vacuum off Turns on or off the vacuum to the vacuum pads on the 
applicator head.

Drop stage/Raise stage Moves the plate stage to the upper or lower stop 
position.

Blowoff on/Blowoff off Turns on or off the blowoff air to the applicator head.
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Sensors area

If a sensor indicator fails to light, the sensor might be faulty or require an adjustment. 
Contact Agilent Automation Solutions Technical Support for assistance.
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Controls and indicators Description

Head retracted Lights when the applicator head is in the retracted 
position (away from the printer).

Head rotated to the 
printer

Lights when the applicator head is rotated to the printer.

Head rotated to stage Lights when the applicator head is rotated toward the 
plate stage.

Vacuum detected Lights when the vacuum is turned on and the vacuum 
pads on the applicator head are holding a label.

Stage home flag 
detected

Lights when the plate stage rotation sensor detects the 
home flag. The light should be lit when the plate stage 
moves counterclockwise from the home position and 
extinguished when the plate stage moves clockwise from 
the home position. 
Note: If the plate stage rotates a full revolution and the 
light does not change state, the sensor might be faulty.

Green button press Lights when the green button on the top of the device is 
pressed and held. 

Pressure (psi) Indicates the current air pressure inside the Microplate 
Labeler after the pressure has been regulated by the 
internal pressure regulator.
The readout should be 80 psi (0.55 MPa), minimum.
• If the readout is <80 psi. Verify that the air source is 

supplying 80 psi (0.55 MPa), minimum. If the source 
is above 80 psi and the readout is below 80 psi, use 
the pressure regulator knob on the back of the 
applicator to increase the pressure.

• If the readout is >87 psi. Use the pressure regulator 
knob on the back of the applicator to lower the 
pressure to 85 psi (0.58 MPa), maximum.

For instructions on setting the air pressure, see “Setting 
the air pressure” on page 38. 
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Label Count Tracking area
The Label Count Tracking settings are saved to the printer.

Barcode Reader area

Controls and indicators Description

Select label roll type Specifies the number of labels on the label roll. 

Labels per roll Available only if you select Custom roll size from the 
Select label roll type list. Allows you to set a roll size other 
than the standard sizes available in the list.

Set custom roll size Available only if the Custom roll size option is selected. 
Applies the value entered in the Labels per roll box.

Labels remaining and 
Labels printed

Specifies labels remaining and the labels printed since 
the counter was reset. 
The labels remaining and labels printed typically equal 
the labels per roll.

Reset counter Resets the label counter so that the Labels printed field 
indicates 0.
Click Reset counter when you load a new roll of labels.

Controls and indicators Description

Last value Indicates the value read by the barcode reader. 
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Related information

Trigger BCR Available only if barcode reader is installed and initialized. 
Causes the barcode reader to scan the label of the 
microplate on the plate stage, and then displays the 
reading in the Last value box.

Controls and indicators Description

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics software” 
on page 139

Plate stage positions “About plate stage and applicator head 
positions” on page 69
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Stage Setup tab

About this topic

This topic provides a quick reference to the controls and indicators in the Microplate 
Labeler Diagnostics—Stage Setup tab. The controls in the Stage Setup tab enable you 
to rotate the plate stage and to reset the plate stage angles (teachpoints) when setting 
up the device.

Figure Stage Setup tab
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Stage Setup tab procedures

The Stage Setup tab enables you to:

CAUTION
The plate stage teachpoints are associated with a specific device profile and stored 
in the Windows registry. If you delete a profile, the teachpoints are also deleted. 

Stage Setup tab contents

The Stage Setup tab contains the following:
• Stage Controls area
• Teachpoints area

Stage Controls area

Procedure See...

Home the plate stage “Using plate stage controls in Diagnostics” 
on page 109

Rotate plate stage “Using plate stage controls in Diagnostics” 
on page 109

Enable or disable plate stage auto-
repositioning

“Using plate stage controls in Diagnostics” 
on page 109

Set teachpoints • “Using plate stage controls in 
Diagnostics” on page 109

• “Setting the robot pickup angle 
teachpoint” on page 76
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Controls and indicators Description

Current stage angle Displays the current angle of the plate stage.
As you face the front of the device, 0 degrees is the left 
side of the plate stage. Rotating the plate stage 
clockwise increases the angle.

Home stage Initiates the homing sequence that searches for the plate 
stage home position and sets that position as 0 degrees.

Angle increment 
(degrees)

Specifies a relative value to use when rotating the plate 
stage using the Rotate CCW and Rotate CW buttons. 
Each time the Rotate CCW or Rotate CW button is 
pressed, the plate stage moves by the specified 
increment in the designated direction.

Rotate CCW Rotates the plate stage counterclockwise by the amount 
specified in the Angle increment box.

Rotate CW Rotates the plate stage clockwise by the amount 
specified in the Angle increment box.

Angle value (degrees) Specifies an absolute value to which the plate stage will 
move when the Move to button is pressed.

Move to Moves the plate stage to the absolute position specified 
in the Angle value box.

Disable stage auto-
repositioning

Enables or disables auto-repositioning for the plate 
stage. 
Default is not selected (auto-repositioning is enabled).
When enabled. If the plate stage is moved from a position 
by an outside force (for example, if someone rotates the 
stage by hand), the auto-repositioning feature 
automatically moves the plate stage back to the last 
angle.
When disabled. If the plate stage is rotated manually it 
remains at the new position. This can be useful when 
setting up, troubleshooting, or performing maintenance 
on the Microplate Labeler.
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Teachpoints area

                                                        

Controls and indicators Description

Robot pickup angle Specifies the position that the plate stage returns to 
when a print-and-apply cycle is completed.
Default setting: 0
For devices that are integrated in a lab automation 
system or workstation, this is the position where an 
external robot picks up or places a microplate on the 
plate stage.
To set the value, use the controls in the Stage Controls 
area to move the plate stage to the desired position. Click 
Teach to set the position.

Apply angle (east side) Specifies the teachpoint position to which the plate stage 
rotates so that the east side faces the applicator head. 
Default setting: 349, approximate
To move the plate stage so that each of the other sides 
face the applicator head, the software uses angles 90- , 
180- , and 270-degrees from the teachpoint.

Read angle (east side) Specifies the teachpoint position to which the plate stage 
rotates so that the east side faces the optional barcode 
reader. 
Default setting: 259, approximate
To move the plate stage so that each of the other sides 
face the barcode reader, the software uses angles 90- , 
180- , and 270-degrees from the teachpoint.

Teach Resets the teachpoint coordinates for the corresponding 
angle.

Move here Moves the plate stage to the corresponding teachpoint.
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Related information

Profiles tab

About this topic

This topic provides a quick reference to the controls and indicators in the Microplate 
Labeler Diagnostics—Profiles tab. You use the controls in the Profiles tab to create or 
modify the device communication profiles and to initialize a profile to use while 
controlling the device from Microplate Labeler Diagnostics. 

CAUTION
Each profile can be used by multiple protocols. Deleting, renaming, or changing the 
parameters for a profile based on one protocol can invalidate other protocols that 
use the profile.

CAUTION
The plate stage teachpoints are associated with a specific device profile and stored 
in the Windows registry. If you delete a profile, the teachpoints are also deleted. 

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics software” 
on page 139

Testing the Microplate Labeler 
functions

“Checking the basic applicator functions” 
on page 104

How the plate stage and applicator 
move

“About plate stage and applicator head 
positions” on page 69
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Figure Profiles tab
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Profiles tab procedures

The Profiles tab enables you to:

Profiles tab contents

The Profiles tab contains the following:
• Profile Management
• Profile Settings

Profile Management area

Procedure See...

Create and manage profiles “Creating a profile” on page 64

Initialize a profile to use in Microplate 
Labeler Diagnostics

“Initializing the device in diagnostics” on 
page 66

Controls and indicators Description

Profile name Displays the list of available profiles, and allows you to 
select a profile to manage. 

Create a new profile Opens the Create Profile dialog box so that you can 
create a new profile.

Create a copy of this 
profile

Creates a copy of the selected profile. 
By default the copy is named, Copy of nnn.

Rename this profile Opens the Rename Profile dialog box where you can give 
a new name to the selected profile.

Delete this profile Deletes the profile selected in the Profile name list. 

Update this profile Saves changes to the selected profile.
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Profile Settings area

Initialize this profile, 
Reinitialize this profile, 
or Close this profile

Initializes or reinitializes the selected profile for 
controlling the device via Microplate Labeler Diagnostics, 
or closes the currently initialized profile.

Controls and indicators Description

Controls and indicators Description

Current IP address Ethernet connection only. When communication is 
established with the device using the given profile, 
displays the current IP address of the device. 

Current MAC address Ethernet connection only. When communication is 
established with the device using the given profile, 
displays the current MAC address of the device. 

Firmware version When communication is established with the device 
using the given profile, displays the current firmware 
version of the device.

Serial connection Serial connection only. Specifies the serial port on the 
computer for serial communication with the Microplate 
Labeler.
Select the computer COM port for the serial connection 
from the list.

Ethernet connection Ethernet connection only. Specifies an Ethernet 
connection for the Microplate Labeler.
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Related information

Device ID Displays the device ID for the Microplate Labeler after 
communication with the device is established.

Select Microplate 
Labeler

Opens the Discovered Bionet Devices dialog box where 
you can select the Microplate Labeler that you want to 
connect to using an Ethernet connection.

Printer type Specifies the printer model. For the Microplate Labeler, 
make sure you select the cab printer.

Label size Specifies the label size.

Disable tracking of 
remaining labels

Disables the remaining value on the I/O Functions tab.

Verify barcodes after 
Print and Apply

Available for optional barcode reader only. Verifies that 
every barcode label that is printed and applied can be 
read by the barcode reader.

Max apply retries The number of times the device will attempt to apply a 
label if the applicator head fails to apply the label to a 
microplate on the plate stage.

Max pick retries The number of times the device will attempt to pick a 
label from the printer before giving up on that label and 
discarding it.

Max print/pick retries The number of times the device will print a new label and 
attempt to pick it before displaying an error. For each 
label that is printed, the device will attempt to pick the 
printed label based on the Max pick retries value.

Controls and indicators Description

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics software” 
on page 139

Connection of the Microplate Labeler “Connecting the device to the computer” 
on page 41

Establishing communications using 
VWorks software

“Creating a VWorks device file” on page 58
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B Templates for barcode formats
This appendix contains the following topics:
• “Templates overview” on page 166
• “Template 1—Code 128 over small text field” on page 168
• “Template 2—Code 128 barcode only” on page 169
• “Template 3—Single large text field only” on page 170
• “Template 4—Big text field and Code 128” on page 172
• “Template 5—Four small text fields” on page 173
• “Template 6—Data Matrix symbology with large text field” on page 175
• “Template 7—Data Matrix symbology with two small text fields” on page 177
• “Template 8—PDF 417 symbology over medium-size text field” on page 179
• “Template 9—PDF 417 symbology over small text field” on page 181
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Templates overview

The Microplate Labeler includes the following set of predefined label formats that are 
ready to use. 
Templates are loaded in the printer and installed in the following folder as XML files:
C:\VWorks Workspace\Microplate Labeler Label Formats

IMPORTANT
Make sure that the barcode reader is capable of decoding the chosen barcode 
symbology before making a final choice in label format. The 2D symbologies 
(Templates 6-9) require a barcode reader that is capable of imaging instead of 
scanning.

Templat
e

Printed image Description

1 Code 128 over small text field. Provides a blend of data 
density, machine readability, and human readability.
For details, see “Template 1—Code 128 over small text 
field” on page 168

2 Code 128 barcode only. Provides the best machine 
readability. You can pair this label with a second label to 
add human-readable text, for example, template 3 or 5.
For details, see “Template 2—Code 128 barcode only” on 
page 169

3 Single large text field only. Provides maximum legibility of 
human-readable text. You can pair this label with a 
barcode-only label, for example, template 2.
For details, see “Template 3—Single large text field only” on 
page 170

4 Big text field and Code 128. Provides the best machine 
readability and human readability in a single label for those 
with smaller amounts of data (10 numerals or 6 alpha 
characters, maximum).
For details, see “Template 4—Big text field and Code 128” 
on page 172

5 Four small text fields. Provides useful amount of human-
readable information that can be added to a microplate 
that already has a barcode label.
For details, see “Template 5—Four small text fields” on 
page 173

6 Data Matrix with large text field. Provides Data Matrix 
version of template 1. The 2D symbology allows space for 
a much larger text field than that in template 1.
For details, see “Template 6—Data Matrix symbology with 
large text field” on page 175
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Related information

7 Data Matrix with two small text fields. Leverages the data 
density of 2D Data Matrix symbology to encode a large 
amount of data.
For details, see “Template 7—Data Matrix symbology with 
two small text fields” on page 177

8 PDF 417 over medium-size text field. Provides 2D 
symbology in a format similar to templates 1 and 6 but 
with slightly more data capacity.
For details, see “Template 8—PDF 417 symbology over 
medium-size text field” on page 179

9 PDF 417 over small text field. Provides the data density and 
shape of 2D PDF 417 symbology to encode the largest 
amount of data on a label this size.
For details, see “Template 9—PDF 417 symbology over 
small text field” on page 181

Templat
e

Printed image Description

For information about... See...

Opening Microplate Labeler 
Diagnostics

“Opening Diagnostics” on page 62

Other tabs in Microplate Labeler 
Diagnostics

“Quick reference to Diagnostics software” 
on page 139

Label formats and content “About label formats and content” on 
page 80

Creating and editing label formats “Creating and editing label formats” on 
page 84

Printing test labels “Performing a print-and-apply test” on 
page 106
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Template 1—Code 128 over small text field

Example label

Label Editor parameters and preview

Overview

Template 1 uses Code 128 symbology, which offers reasonable data capacity and can 
be read by a great range of readers. The barcode stretches the length of the label to 
enable maximum data capacity. The text field can be used to repeat the barcode data 
as human-readable text. 

Specs for symbology

Maximum data: 24 numerals or 12 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
Note: Higher data density for numerals is achieved because they are encoded in pairs. 
So, a number with 23 numerals will not fit. 

Design features

• Code 128 is commonly used and offers good data density for this size label. 
• The narrow bar width gives good readability and accommodates a good amount 

of data.
• The left blank margin is 1.27-mm (0.05-in) wider than the minimum required quiet 

zone of 10 times the narrow bar width. 
• The blank margin to the right of the barcode will fluctuate in size with the amount 

of data encoded. The example shows the maximum length barcode while still 
maintaining a 3.81-mm (0.15-in) right margin.
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• The barcode extends to the top of label to maximize use of vertical space. The 
barcode height offers reasonable vertical redundancy to facilitate machine 
readability, and still allows room for a text field that is legible.

• Minimal space separates the barcode and the text field.
• The text field is left-justified to allow longer strings to fit on the label. The Droid 

Mono Bold font offers consistent character spacing, and the font is small to allow 
maximum space for the barcode, while still providing legible text.

• A 0.51-mm (0.02-in) blank margin below the text allows for some vertical drift in 
the printing.

Template 2—Code 128 barcode only

Example label

Label Editor parameters and preview

Overview

Template 2 provides machine readability. You can pair this label with a second label to 
add human-readable text, for example, template 3 or 5.

Specs

Maximum data: 24 numerals or 12 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
Note: Higher data density for numerals is achieved because they are encoded in pairs. 
So, a number with 23 numerals will not fit. 
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Design features

• Code 128 is very common and offers good data density for this size label. 
• The narrow bar width gives good readability and accommodates a good amount 

of data.
• The left blank margin is 1.27-mm (0.05-in) wider than the minimum required quiet 

zone of 10 times the narrow bar width. 
• The blank margin to the right of the barcode will vary depending on the amount of 

data encoded. The example shows the maximum length barcode while still 
maintaining a 3.81-mm (0.15-in) right margin.

• The barcode extends to the top of label to maximize use of vertical space. 

Template 3—Single large text field only

Example label

Label Editor parameters and preview

Overview

Template 3 is a text-only label format, designed to be paired with the barcode-only 
label in Template 2.

Specs

Maximum data: 24 characters, any type
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Design features

• The Droid Mono Bold font offers consistent character spacing, discernible 
characters, and a modern, look.

• The text height is maximized within the height of the label.
• A blank margin above the text allows for 0.76-mm (0.030-in) vertical print drift.
• A blank margin below the text allows room for lowercase descenders, such as g or 

q, while also providing allowance for vertical print drift.
• The generous left margin allows for horizontal print drift. The print drift 

specification is ±0.76-mm (±0.030-in) for positioning the edge of the label to the 
edge of the label backing.

• The size of the right margin varies depending on the number of characters.
• The horizontal scaling of the text field squeezes enough characters onto the label 

to match the maximum data encoded in the barcode on the Template 2 label. 
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Template 4—Big text field and Code 128

Example label

Label Editor parameters and preview

Overview

Template 4 provides the best machine readability and human readability in a single 
label for those with smaller amounts of data (10 numerals or 6 alpha characters, 
maximum).

Specs 

Maximum data: 10 numerals or 6 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
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Design features

• Code 128 is very common and offers good data density for this size label. 
• Narrow bar width gives good readability and accommodates a good amount of 

data.
• The blank margin to the right of the barcode will fluctuate in size with the amount 

of data encoded. The example shows the maximum length barcode while still 
maintaining a 3.81-mm (0.15-in) right margin.

• The barcode extends from top to bottom to maximize vertical redundancy, which 
facilitates machine readability.

• Minimal space separates the barcode and the text.
• The blank margin separating the text field and the barcode is 0.64-mm (0.025-in) 

wider than the minimum quiet zone required for machine readability.
• The Droid Mono Bold font offers consistent character spacing, discernible 

characters, and a modern look.
• The text height is maximized within the height of the label.
• A blank margin above the text allows for 0.76-mm (0.030-in) vertical print drift.
• A blank margin below the text allows room for lowercase descenders, such as g 

and q, while also providing allowance for vertical print drift.
• The left margin allows for horizontal print drift. 
• The horizontal scaling of the text field squeezes enough characters onto the label 

to match the maximum data encoded in the barcode.

Template 5—Four small text fields

Example label

Label Editor parameters and preview



B   Templates for barcode formats
Template 5—Four small text fields

174 G5581A Microplate Labeler User Guide

Overview

Template 5 features four text fields. This text-only label can be paired with a barcode-
only label, such as Template 2, on the same microplate.

Specs for text

Fields 1 and 2 (left): 20 characters, maximum
Fields 3 and 4 (right): 13 characters, maximum

Design features

• The Droid Mono Bold font offers consistent character spacing, discernible 
characters and a modern look.

• The text height is scaled to fit one field above the other in the vertical space. 
Horizontal scaling offers good data density without sacrificing legibility.

• Above the text, a blank margin allows for some vertical print drift.
• Adequate space separates each field to prevent characters from overlapping, even 

with a mix of uppercase and lowercase characters.
• Below the text, a blank margin allows room for lowercase descenders, such as g 

and q, while also providing allowance for vertical print drift.
• Generous left and right margins allow for horizontal print drift. 

The print drift specification is ±0.76-mm (±0.030-in) for positioning the edge of the 
label to the edge of the label backing.

• The usable width of fields 1 and 2 (left) is slightly greater than fields 3 and 4 (right), 
offering options for both longer and shorter data sets.
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Template 6—Data Matrix symbology with large text field

Example label

Label Editor parameters and preview

Overview

The Data Matrix symbology (with this dot size) encodes roughly the same amount of 
data that can fit on a label with the Code 128 symbology. So, Template 6 is analogous 
to Template 1. Because the Data Matrix symbology is so much denser than the 
Code 128 symbology, the text field can be much larger than the corresponding one 
that is paired with Code 128 in Template 1.

Specs 

Maximum data: 24 numerals or 16 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
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Design features

• Data Matrix is a very dense and popular 2D symbology.
• The dot size used in this template is conservative for good readability.
• Generous margins are provided on both the right and left of the barcode.
• The blank margin above the barcode allows for 0.76-mm (0.030-in) vertical print 

drift.
• The blank margin below the barcode will vary depending on the amount of data 

encoded. The example shows the maximum data length while still maintaining a 
0.76-mm (0.030-in) bottom margin.

• The barcode is positioned to the left of the text in the event that too much data is 
used for the text fields. In this case, the text will run off the right edge of the label 
and will not interfere with the barcode.

• The Droid Mono Bold font offers consistent character spacing, discernible 
characters, and a modern look.

• The font size is large to offer optimum legibility.
• The text field is scaled horizontally so it can fit enough characters to match the 

data that can be encoded in the barcode.
• The text field is left-justified to allow for the longest possible strings for the 

available space.
• Generous space above and below the text allow for vertical print drift.
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Template 7—Data Matrix symbology with two small text fields

Example label

Label Editor parameters and preview

Overview

The use of the Data Matrix symbology with this dot size allows a large amount of data 
to be encoded into a symbol that only uses a small portion of the label. Template 7 
leverages the large remaining space for two text fields. The upper text field can contain 
any extra information that might be useful on the label. The lower text field is sized to 
match the same number of characters that can fit in the barcode.

Specs 

Maximum data: 36 numerals or 25 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
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Design features

• Data Matrix is a very dense and a very popular 2D symbology.
• The dot size used in this template is relatively conservative for readability, but still 

allows for twice the amount of data that can fit on a label with the Code 128 
symbology.

• Generous margins are provided on both the right and left of the barcode.
• The blank margin above the barcode allows for 0.89-mm (0.035-in) vertical print 

drift.
• The blank margin below the barcode will vary depending on the amount of data 

encoded. The example shows the maximum data length while still maintaining a 
0.89-mm (0.035-in) bottom margin.

• The barcode is positioned to the left of the text in the event that too much data is 
used for the text fields. In this case, the text will run off the right edge of the label 
and will not interfere with the barcode.

• The Droid Mono Bold font offers consistent character spacing, discernible 
characters, and a modern, attractive look.

• Text field 1 (top) offers good legibility and space for up to 26 characters.
• Text field 2 (bottom) compresses the horizontal scaling to match the data that can 

be encoded in the symbol.
• The text fields are left-justified to allow for the longest possible strings in the 

available space.
• Margins above and below the text are adequate to allow for some vertical print 

drift.
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Template 8—PDF 417 symbology over medium-size text field

Example label

Label Editor parameters and preview

Overview

The PDF 417 symbology can be used to create a template that is analogous to 
Templates 1 and 6. In this case, slightly more data can be encoded than in either the 
Code 128 or Data Matrix symbologies, while maintaining a medium-size text field.

Specs 

Maximum data: 33 numerals or 24 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
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Design features

• PDF 417 can encode large amounts of data.
• The narrow bar width used in this template provides good readability while 

allowing a large amount of data to be encoded.
• In compliance with recommended practices, the format features a row height at 

least three times the narrow bar width.
• The symbol aspect ratio is set so the symbol will stretch across the label and allow 

space below the barcode for text.
• The format uses the printer's default error level of 0.
• Generous margins are provided on both the right and left of the barcode.
• A blank margin above the barcode allows for 0.76-mm (0.030-in) vertical print drift.
• The space below the symbol will vary depending on the amount of data encoded. 

The example shows the maximum data length, while still maintaining a 0.25-mm 
(0.01-in) margin to separate the text and the barcode.

• The Droid Mono Bold font offers consistent character spacing, discernible 
characters, and a modern look. 

• The font size is larger than what is used with Code 128 in Template 1 but smaller 
than what is used with Data Matrix in Template 6.

• The text field is scaled horizontally to match the data that can be encoded in the 
barcode.

• The text has a generous margin on the left. The margin on the right will vary 
depending on number of characters.

• The text field is left-justified to allow for the longest possible string in the available 
space.

• A blank margin below the text allows for some vertical print drift.
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Template 9—PDF 417 symbology over small text field

Example

Label Editor parameters and preview

Overview

Template 9 features the PDF 417 symbology, which can encode the most data on this 
size label. To fit the same amount of data in the text field that can be encoded in the 
barcode, the text field is small and compacted horizontally.

Specs 

Maximum data: 58 numerals or 41 alpha characters (The maximum alphanumeric 
length depends on the character mix.)
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Design features

• PDF 417 can encode large amounts of data.
• The narrow bar width used in this template provides good readability while 

allowing a large amount of data to be encoded.
• In compliance with recommended practices, the format features a row height at 

least 3 times the narrow bar width.
• The symbol aspect ratio is set so the symbol will stretch across the label and allow 

space below the barcode for text.
• The format uses the printer's default error level of 0.
• Generous margins are provided on both the right and left of the barcode.
• A blank margin above the barcode allows for 0.76-mm (0.030-in) vertical print drift.
• The space below the symbol will vary depending on the amount of data encoded. 

The example shows the maximum data length, while still maintaining a 0.51-mm 
(0.02-in) margin to separate the text and the barcode.

• The Droid Mono Bold font offers consistent character spacing, discernible 
characters, and a modern look.

• The font size is small to fit the available space, but is still legible.
• The text field is scaled horizontally to match the data that can be encoded in the 

barcode.
• The text has a generous margin on the left. The margin on the right will vary 

depending on number of characters.
• The text field is left-justified to allow for the longest possible string in the available 

space.
• A blank margin below the text allows for some vertical print drift.
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